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Introduction
Until this program release on Macintosh and Windows platforms, Obspat
was owned and maintained by Arthur K. Peters, Consulting Engineers.
Obspat was used by that firm and was also offered to the public using a
dial-up, time-share arrangement on a pay–per–pattern basis. Many
organizations, antenna manufacturers, consultants and individuals regularly
use Obspat. Others that needed only occasional patterns used the consulting
services of Arthur K. Peters. The name Obspat is derived from “obstacle
pattern” or “obstructed pattern”
If you are new to Obspat, but have ever requested a pattern from an antenna
manufacturer, chances are that you are already familiar with the most
common Obspat product, a horizontal plane radiation pattern. This pattern
shows an antenna’s expected pattern distortions produced by metallic
objects in the vicinity of the antenna. Metallic objects at typical antenna
sites take many forms. Tower members, guy wires, other antennas and
transmission lines are the most common.
Obspat was originally created to help field personnel analyze and solve
commonly encountered problems with transmission and reception. An
example: One stands about a mile away in plain view of an antenna on a
tower and is unable to receive its transmissions. A few simple inputs to
Obspat, describing the antenna and metallic objects around the antenna,
often shows graphically that the antenna pattern is grossly distorted by
those objects. The problem is frequently resolved with simple changes of
antenna position. Obspat can tell you how much and in what direction to
reposition the antenna, without having to resort to expensive, physical trial
and error methods.
Obspat is also commonly used to create or synthesize custom antenna
patterns. This is accomplished by entering simple distance and direction
data along with the names of one or more stock antenna patterns supplied
with Obspat. By changing powers, phases, pattern orientations and other
factors, virtually any conceivable pattern shape may be generated. Reduced
field intensity toward a co-channel area, or, notching a pattern in some
direction to minimize interference is routinely available to Obspat users.
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Antenna files not included on the Obspat distribution CD may be imported
using a number of common industry antenna file formats. Obspat antenna
files may also be exported to those file formats. Thus, Obspat provides a
format translation mechanism.
A number of Import and Export antenna file formats are supported in
Obspat. Import routines convert formatted antenna files to the internal
Obspat format. Export routines convert internal Obspat antenna files to
formatted files. If a non-listed format is desired, please notify us. We will
require a complete definition of each field in the file as well as a
description of possible field variants, if any.
This manual has been designed for fast user implementation. Reading the
installation, setup, preference selection and the data entry Sections will
have the user producing patterns. Hints and tips reflecting decades of reallife experience with Obspat are included throughout. Paying attention to
those factors will more rapidly improve the user’s facility with Obspat

1

Program Details
1.1
Terms And Definitions
Obspat refers to the executable application file. It also refers to the overall
trademarked name of the suite of data files and folders. Obspat is licensed
to a single computer. Reinstalling on another computer is provided for.
Antennas are individual files (with .opa extensions and document icons
containing a capital “A”) of one antenna or antenna configuration. Antenna
files are listed in and may be selected from a contextual (pull-down or
drop-down) menu while running Obspat. The antennas displayed in the
contextual menu may be culled using various criteria.
Situations are individual files (with .ops extensions and document icons
containing a capital “S”) that are generated from a particular problem or
session. For example, an antenna and some obstacles are stored to be later
recalled. Each ‘situation’ file is assigned a name that may be selected from
a pull-down menu. Culling entries in this list is under user control.
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The terms folder and directory have the same meaning.
1.2
Obspat Components
The executable application may be installed at any convenient location on
the computer. Application aliases or shortcuts may also be placed
anywhere, such as the desktop, etc. However, Windows versions are
installed in specific locations.
A database file with the name ObspatDB.rsd is used to process and hold
antenna and situation names. Obspat will not operate without one of these
database files. This file may be placed in a folder with the several other
folders described next. There may be more than one of these files in the
computer, possibly describing different groups of antennas and situations.
Data folders. These folders may have names like Antennas, Situations,
Import and Export. For convenience these folders may be kept in a data
folder along with the database file.
A preferences file (ObspatPreferences) is maintained for each user. Each
preferences file contains various parameters, file path descriptions and user
entered print title data. There may be times when this file must be
eliminated. A simple Search (or find file) will identify its specific location.
There are no restrictions on folder names or on the number of folders
contained in a data folder. However, the database file itself must have the
case sensitive name ObspatDB.rsd. Thus, in a folder there can be only one
database file with that name. Other database files with different names may
co–exist but will be ignored by Obspat.
Each data folder may contain any number of antenna and situations folders,
each having a unique name. Each folder may contain any number of
uniquely named files. Other folders holding, for example, antenna files to
be imported or exported, have similar considerations.
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1.3
Create Database File
A new database file may be created by selecting the menu Tools>Create New
Database File. This will place an empty database file in a place designated by
the user.

2

Installation
This process depends upon how the user desires to utilize Obspat.
2.1
Single Computer
The simplest configuration is operation on a single computer. To install,
drag the installer from the CD to your desktop. Double click and follow
instructions. If this is not a new installation, before installing, please search
for and delete any files named ObspatPreferences. (The Antenna Data files
may be dragged to any convenient location at any time as needed.)
Once the application is installed, double-click the Obspat icon. For
Windows, this is located in Start>Programs>Obspat. The user will then be
asked via three dialogs to locate 1) the database file folder containing the
file with the case sensitive name ObspatDB.rsd, 2) the folder containing
antenna files and 3) the folder containing situation files. Obspat will then
display its main screen. These folders may be found on the Desktop in the
‘ObspatData’ folder.
2.2
Network
For network operations it is not necessary to have copies of the folder
containing a database file (ObspatDB.rsd) on each computer. However, it is
required that an Obspat application be placed on each client computer. On
multi-user computers, all users may access Obspat and will be provided
with separate preferences for each user.
The computer containing the database must be accessible to other
computers and users on the network. If you have trouble accessing the
database, notify your network administrator. Be certain the database is
sharable by others. In some cases, the database file may be more easily
accessed if attached to a dedicated shared user. Also be certain the database
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file has adequate permissions enabled for reading and writing by remote
users. With network access functioning properly, network operations are
the same as single computer operations.
Antenna and situation files and folders may reside on any or all client
computers and/or on a server. This also applies to database files.
Once the application is installed, double-click the Obspat icon. For
Windows, this is located in Start>Programs>Obspat. The user will then be
asked via three dialogs to locate 1) the database file folder containing the
file with the case sensitive name ObspatDB.rsd, 2) the folder containing
antenna files and 3) the folder containing situation files. Obspat will then
display its main screen. These folders may be found on the Desktop in the
‘ObspatData’ folder.
2.3
File And Folder Locations
Data folders and files may be located anywhere. Networked users may
access them anywhere on the network and use them as their own. Single
computer users may have folders located anywhere on their computers.
This permits subsets of antennas and situations to be stored or grouped as
desired. For example, situations may be grouped by system, region,
country, etc. Antenna files could also be grouped in separate folders by
frequency, type, manufacturer, etc. (Obspat provides methods for users to
select the antennas and situations to be displayed in pull down menus.)

3

Preference File
Obspat maintains on each computer, for each user, a file named
ObspatPreferences. In that file are all of the user selectable options
including data units and user entered titles to be printed on data sheets and
pattern plots. Preferences are automatically saved when Obspat quits. All
of this information is saved in the preferences file and will not be requested
again unless the preferences file has been replaced.
Because the possible names and locations of Obspat data files are limitless,
there may be occasions when the user or application becomes confused. If
this occurs, locate the ObspatPreferences file and move it to the trash. This
Obspat Instruction Manual
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will force Obspat to start from scratch including re-entering title
information, navigating to various data folders and resetting selection and
culling parameters.

4

Menu Descriptions
In the Obspat menu bar are standard functional and operational selections
such as Edit and Help. Other functions specific to Obspat are found in the
File and Tools menus. These Obspat functions are described here.
4.1
File Menu
Open Situation – Presents a dialog listing the Situations in the currently
selected Situation folder. When selected, a Situation is then displayed.
This performs a similar function as the Situation pull down menu on the
Situation screen.
Open Antenna – Presents a dialog listing the antennas in the currently
selected Antenna folder. When selected, an antenna is displayed on the
Antenna screen. While this function may be performed in the Antenna table,
this function will not automatically place the antenna in the Antenna table.
Save Situation – Saves the currently displayed Situation. May be invoked
using Ctrl-S (Cmd-S) keys.
Save Situation As – Presents a dialog to name the current Situation. Then
saves the current Situation with the new name in the current Situation folder.
Save/Export Sit Pattern As Antenna – Formats the displayed screen pattern as
an antenna and displays it in the Antenna screen. It may then be stored as an
antenna. It may also be exported with or without saving as an antenna.
Print Pattern – Prints the displayed pattern and other user specified data on
the currently selected printer.
Print Obspat Situation File – Prints the displayed Situation file in Obspat’s
internal format. This file is meaningless to humans and is subject to change.
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Print Obspat Antenna File – Prints the displayed Antenna file in Obspat’s
internal format. Some information may be useful, but not often.
4.2
Tools Menu
Delete Existing Situation – Deletes the displayed Situation.
Antenna – This has four sub functions.
Select For Antenna Table – This is an alternative to using the pull
down menu and mouse for selecting an antenna from the current
Antenna folder. It may be invoked using Ctrl-A (Cmd-A) keys. Enter
the desired Antenna row number and select the antenna name.
Delete Existing – This deletes the displayed antenna.
Import Antenna File(s) – Imports into Obspat, from the currently
specified Import folder, antennas using a variety of common file
formats. When all imported files have the same format they may be
batch processed.
New – This is the mechanism to enter an antenna manually.
Calculate Face Position – Through a dialog the position of an Obstacle or
Antenna may be found without calculation. Operation is invoked either by
Shift-clicking in the Obstacle or Antenna tables, or, by using the Ctrl-F
(Cmd-F) keys. Using keys requires specifying the table and row.
Rebuild – Has three options.
Antenna List – This forces Obspat to rescan the currently selected
Antenna folder and build the antenna list. Helpful when files have
been moved to or from the folder manually.
Situations List – This is similar to the Antenna List except it pertains
to the currently selected Situations folder.
Manufacturers List – Selection preferences such as listing antennas
from selected manufacturers may be employed to limit the list of
antennas displayed by Obspat. See Preference Pages.
Obspat Instruction Manual
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Select Data Folder – Has five submenus. Each is selected using a dialog that
requests the folders to be used as defaults by Obspat. The folders may have
any name and may occur at any accessible location. The folders are Antenna,
Situations, Data Base, Import and Export.
Create New Data Base File – This menu, through a dialog, creates a new
database in a folder selected by the user. The database maintains the various
lists used by Obspat. It is affected by antenna, situations and manufacturer
operations and is automatically updated. If a database problem occurs, the
database may be deleted and restored using the ‘Rebuild’ operations.

5

Starting Obspat
Once installed, Obspat may be started in all of the usual ways according to
the particular platform.
5.1
Normal
Windows users may use the Start>Program menu, double-click the
program icon, double-click any Antenna or Situation files or double-click a
shortcut. Mac users have similar availability.
5.2
Emergency
Obspat normally starts using the user preference file that contains paths to the
previously selected working directories. This includes the database file
(ObspatDB.rsd) and the antenna and situation folders.
Obspat can be made to start when one or more of these folder locations are
missing from the user preference file. Double-click the Obspat program icon.
As each folder location is requested in a dialog, click cancel. Many warning
messages may be issued. Simply dismiss them. Eventually, the main screen
will appear. If the database file is missing, a new one may be created using
the menu Tools> Create New Database File. Then invoke the menu Tools>
Select Data Folder> Data Base Folder to select the location of the newly
created database file.
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Similarly, the antenna and situation folders may be created and then located
using Tools> Select Data Folder, if required.

6

Program Setup and Preference Pages
To begin, start Obspat in the usual manner. A splash screen will appear
followed by the main Obspat screen.
Select Obspat Preferences. (Win – under Tools) (Mac – under Obspat) A
tabbed panel will appear with the following tabs.
To make any changes permanent at once, quit and restart Obspat. This is a
convenient way to set default preferences. Otherwise, continue with your
work and when finished exit the program normally. The Preference file is
rewritten during the exit sequence.
6.1
Print
This page provides for setting various title information for pattern plots and
for selecting the number of data sheet pattern values printed by Obspat. The
page is fairly intuitive and any desired information may be entered.
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A check box is provided to cause a data sheet to be printed with a pattern
plot. Obspat computes 360 pattern values for every pattern. If ‘Print Data
Sheet’ is enabled, Obspat will print all input data information including
time, date, etc. If ‘No. Data Points’ has a value greater than zero, that
number of pattern values will be appended to the data sheet. Azimuth
intervals are adjusted by entering a value equal to 360/(desired azimuth
increment). For example, the value 72 will print azimuth and data values
with increments of 5 degrees (360/5 = 72).
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6.2
Resolution
Values on this page set screen and print resolutions. Windows users should
not set the print resolution greater than the maximum resolution capability
of the printer. Doing so will cause the image to expand beyond sheet
boundaries.
The screen resolution should remain at the default value of 72 dots per
inch. This is the only screen resolution value supported at the present time.
The print resolution is set to 300 dpi by default. Other values may be
entered to adjust the output print resolution. Printers capable of 300 dpi will
produce an adequate pattern plot. A greater resolution value will produce
marginally higher-quality plots with increased print file sizes.
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6.3
Units
Program input and output units are selected using pull down menus.
The available output units are dBd, dBi and Field. DBd and dBi are
decibels with reference to a one-half wavelength dipole antenna or an
isotropic antenna, respectively. Field is the absolute electric field gain
referenced to the electric field of a one-half wavelength dipole.
Each of the available output units may also be referenced to the maximum
pattern gain by selecting the ‘Relative’ checkbox. Antennas are frequently
described using relative pattern values and a maximum gain. Obspat can
directly utilize (and transform) relative dB and field values.
Other pull-down menus on this page select the distance, angle, power ratio,
diameter and preferred input gain units. Distances/lengths may be given in
12 Obspat Instruction Manual

feet or meters. Geometric angles and current phases may be given in
degrees or radians. Power divisions/losses may be given in dB or
percentage. Diameters and radii may be given in inches or cm. Gains input
to Obspat by the user may have units of dBd, dBi or Field.
Select unit values now. They will remain in effect as long as the Obspat
Preferences file remains intact. If the Preferences file is damaged or
discarded, all units must be reselected if they differ from Obspat’s defaults.

6.4
Selection Criteria
The need for culling antennas and situations arises when the number of
antennas and situations becomes large. This page contains information and
value fields used to select antennas and situations that will be displayed in
their respective menus. Each of the fields limits the number of antennas and
situations appearing in those menus. For example, the ‘All’ checkbox
Obspat Instruction Manual
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above the list of antenna manufacturers may be disabled and one or more
manufacturers may be individually selected. The antennas from nonselected manufacturers will no longer appear in the antenna menu.
Empty categories on this page exclude any culling in those categories. For
instance, if nothing is entered in the two frequency fields, frequency will
not be used to limit antennas appearing in the menu. If all fields are empty,
all antennas will appear in the menu, assuming ‘all’ manufacturers are
selected.
There are two fields to limit antennas by frequency. Entering values in both
Low and High fields will select antennas with operating capabilities within
that frequency range. A Low value by itself will select antennas with
operating capabilities at or above the entered frequency. Similarly, entering
a frequency only in the High field selects antennas capable of operation at
or below that frequency. Obspat antenna files have provisions for storing
the high, low and measured pattern frequencies. Because one or more of
these values are sometimes missing or unavailable, Obspat will not reject
an antenna if required frequency information is missing from an antenna
file. Thus, all antenna files missing frequency information will also appear
in the antenna menu. Obspat has provisions to amend antenna files to insert
or correct information.
High and Low gain values also may be used to limit antenna menu entries.
As with frequency values, both or either may be entered. Note that the units
of these gain fields should be the same as the ‘Input Gains’ units selected
on the Units preference page.
Half-power beam widths may also be used to limit antenna selection. In
this case the values entered are the maximum acceptable beam widths.
These are entered using the ‘Angles/Phases’ units selected above. Antennas
with vertical or horizontal plane beamwidths greater than entered values
will not appear in the menu. Entering only one value will cause Obspat to
show antennas in the selected plane having half-power beam widths less
than or equal to that value. If an antenna file is missing these values, the
antenna will be included in the menu without regard to selection entries.
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The polarization of an antenna may also be used to limit the number of
antennas displayed in the menu. If a Polarization value is present in the
antenna file, this entry will be used to limit displayed antennas. As before,
an empty field in an antenna file will not reject an antenna on the basis of
polarization. Multiple polarizations can be selected by separating each
entry with a comma. For example, entering a ‘v’ will select only antennas
with vertical polarizations. Entering ‘v,h’ will select all antennas that have
either vertical or horizontal polarizations. Obspat determines a correct
match by searching both the (comma separated) available polarization and
pattern polarization fields stored in the antenna’s file. An antenna may have
several available polarizations. (For example, a yagi antenna that can be
mounted vertically or horizontally.) Obspat has provisions for storing and
editing all polarization abbreviations. Polarization may also be used to
group antennas by assigning, for example, a special polarization
abbreviation to a group of antennas and then selecting those antennas using
that abbreviation. Multiple polarizations in this field may be entered in any
order. Note that polarizations are case sensitive.
Situations will display in the menu if entries in the ‘Situations’ field appear
somewhere in a situation file name. Multiple entries, using comma
separations, may be used to select situation files with different names. For
example, an entry in this field of ‘ia’ will select all situation files
containing ‘ia’ somewhere in their names. Georgia8-456, Georgia8-22
would both be selected. Be cautious here because so would situations with
names like Indiana and Virginia. Note that situations are case sensitive.
As mentioned, Obspat can also use multiple folders as a mechanism to
reduce or customize the antenna and situations menus. The user may select
other antenna and/or situation folders into which subsets of antennas and
situations have been placed. Even the database file (ObspatDB.rsd) may be
replicated and be incorporated into a subset folder to act as a totally
sufficient and independent data set. Subsets may be created for such
reasons as separating by client, region, system and so on.
Finally, on this page is a checkbox labeled ‘Duplicate rows on data input’.
This tells Obspat to attempt to place into the following row a value just
entered. Frequently, data entered into the obstacle and antenna tables are
repetitious. For example, a triangular tower has all three legs the same
Obspat Instruction Manual
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height and diameter and distance apart (face width). When entering this
data a value entered for a tower leg height, for example, is automatically
also placed in the same column of the following row when this option is
enabled. All row data is ignored unless the row is enabled.

7

Data Entry
Once a table has been selected you can move from cell-to-cell easily by
holding the Control (Mac Cmd) key down while using the arrow keys.
Data entered in any text fields or tables may be edited in the usual manner
using copy (Ctrl-C, Mac Cmd-C), paste (Ctrl-V, Mac Cmd-V) and cut
(Ctrl-X, Mac Cmd-X). Text must be highlighted to copy or cut. Paste will
replace highlighted characters or insert the text at the cursor if no
characters are highlighted.
Section 6.4 explains a special provision for duplicating data entry in the
Obstacle and Antenna tables. This user selectable feature automatically
loads table information into the next row during data entry. It can save
time, particularly when there are numerous obstacles or antennas to enter.

--------Obstacles------

--------------------Antennas-----------------

Obspat uses simple geometrical descriptions thereby making data entry
very easy and fast. It virtually eliminates the need to arithmetically
calculate positions or directions through the use of very life-like input data.
This Section pertains to the entry of data in the main Obspat screen. Two
tables, obstacle data on the left and antenna data on the right, are described
first, followed by other data entry issues.
Horizontal plane patterns are displayed with the direction ‘North’ toward
the top of the polar graph. Clockwise rotation from the top (0 degrees)
proceeds to the directions East, South and West at azimuths 90, 180, and
270 degrees, respectively.
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Vertical plane patterns are displayed with an antenna’s main (North) lobe
toward the right on a polar graph, the horizontal axis representing the
horizon. Rotation clockwise (from the right) proceeds below the horizon to
180 degrees, then above the horizon to 360 (zero) degrees.
These conventions are used for all prints, displays, and data input and data
output.
Various issues and parameters and practical suggestions are discussed
throughout this manual. Some elementary issues are introduced in this
Section, reserving more complex issues for later Sections.
7.1
Reference Point
Every problem has a reference point, whether or not it is explicitly defined.
The data entry tables each have a ‘Ref’ column. Recall that Obstacles are
entered in the left table and Antennas in the right.
In the left obstacle table, the ‘Ref’ can contain either zero or the number
(N) of another obstacle in this table. This permits obstacles to be referenced
to a fixed reference point (zero) or to another obstacle. The ‘Ref Dis’ and
‘Ref Dir’ columns are respectively the distance and direction from the
reference to the obstacle.
In the right antenna table, the ‘Ref’ can similarly be referenced to the fixed
reference point by entering a zero, or, to an obstacle by entering the
obstacle’s number (N). An antenna cannot be referenced to another
antenna. As with obstacles, the ‘Ref Dis’ and ‘Ref Dir’ columns are
respectively the distance and direction from the obstacle (or reference
point) to the antenna.
Although the above may now appear confusing, usage is not confusing and
is very intuitive. Consider a 24-inch triangular tower with a north leg and a
south face. Assume an antenna is to be attached to the north leg. For the
north leg, data entry could be zero, zero and zero for Ref, Ref Dis and Ref
Dir, respectively. Obviously, in this case, the north leg is being placed at
the reference point. The southeast leg could be entered zero, 2 (feet) and
150 (degrees). The southwest leg would then be entered zero, 2 (feet) and
Obspat Instruction Manual
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210 (degrees). Sketch these on a diagram, recalling that interior angles of
these triangles are 60 degrees.

For an antenna mounted north of the north leg at a distance of 2, the Ref,
Ref Dis and Ref Dir values may be either (0,2,0) or (1,2,0). The former
references the fixed reference point (of zero) while the latter references
obstacle one. Since obstacle one is at the fixed reference point, either value
set gives the same result.
The other two tower legs can be similarly entered; the SE leg as (1, 2, 150)
and the SW leg as (1, 2, 210). These value sets indicate the two legs are
referenced to the north leg.
Another variation could be to reference the SW leg to the SE leg by
entering (2, 2, 270) for the SW leg. In this case the SW leg is 2 feet directly
west of the referenced SE leg. (The SE leg is here assumed to have been
entered in the N = 2 row.)
Antennas are similarly referenced, but as indicated above, only to the fixed
reference point or to an obstacle. This technique permits many
simplifications. For example, antennas may be referenced (mounted) on
any leg and pointed in a direction relative to that leg. Such data is very
frequently given in a phrase such as “… mounted on the SE leg on a 6-foot
arm pointed south.” That phraseology is directly entered into Obspat with
no positional calculations (nor much thought) required. As a test, what
would the entries be for such an antenna? Probably something like (2, 6,
180).
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7.2
Selecting And Displaying An Antenna
Suppose that a print of an antenna’s radiation pattern is desired. Selection
of the antenna from the antenna menu is all that is required. In the antenna
table move the mouse cursor to some cell of the ‘Ant/Pat Name’ column
and depress the right mouse button. (Mac users hold down the Control key
while clicking the mouse.) The antenna menu will appear listing antennas,
possibly culled by selection criteria discussed above. Scroll to the desired
antenna name to select it. That name will appear in the ‘Ant/Pat Name’
column, in the row the cursor was on when it was clicked. This process
may always be used for antenna selections from the antenna menu.
If the antenna file name is known exactly, it may be typed in the ‘Ant/Pat
Name’ column instead of using the antenna menu. Another method is to
select an antenna in the menu bar under Tools>Antenna>Select For
Antenna Table.
The latter is equivalent to depressing the Control-A (Mac Cmd-A) keys.
A dialog will ask for the antenna row number (N) in which the selected
antenna is to be inserted. The antenna menu will then appear for a selection
to be made.
Enable the antenna by clicking the checkbox at the beginning of the row
containing the antenna name.
Notice that once an antenna has been selected and enabled, Obspat places a
small black circle in the area above the GO button. This represents the
enabled antenna. (As each antenna and obstacle is added and enabled, this
area shows a scaled plan view that is very handy to reduce confusion,
especially for situations having many antennas and obstacles. It is referred
to in this manual as a scaled drawing.)
That ends the required data entry for an antenna. Now click the GO button
or press the Enter key. The pattern associated with the selected antenna is
displayed on the screen.
When within the pattern display (white) area, the mouse cursor causes the
azimuth and pattern values to be displayed to the right of the pattern.
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7.3
Printing a Pattern
With an active pattern displayed on the screen, select Print from the File
menu to print the pattern and data sheet, if enabled. An active pattern may
also be printed by depressing the Ctrl-P (Mac Cmd-P) keys. An active
pattern is one that has at least one enabled antenna entered in the antenna
table.
7.4
Obstacle Entry
A more complex situation or problem turns out to be not much more
difficult to implement. We will now add a metallic object (obstacle) to the
problem. For the moment, to avoid any confusion, disable the antenna by
again clicking its checkbox.
Note that as each table cell is selected, a description of its function and the
expected data units are displayed beneath the tables.
Enter an obstacle in the Obstacle (left) table by filling in the cells along one
row with ‘Ref Dis’, ‘Ref Dir’, ‘Diam’ and ‘Height’. Because we want this
obstacle to be at the reference point, set the distance and direction to zero.
(Actually, only the distance needs to be zero.) Enter a diameter of 6 in the
Diam column. Enter an obstacle height of 200 in the Height column.
Enable the obstacle by clicking its checkbox. The 6 diameter, 200 height
obstacle (a tall pole) is now located at the reference point and is enabled.
Notice that Obspat has placed a red dot, numbered 1, in the scaled drawing.
7.5
Side-mounting An Antenna
Assume the antenna is to be mounted to the pole (obstacle) about halfway
up. Enable the antenna again by clicking its checkbox.
The antenna symbol now obscures the red obstacle dot because it is located
at the same position as the obstacle. Move the antenna by entering 2 in its
‘Ref Dis’ cell. The antenna moves up (North). Now enter 100 in the
antenna’s ‘CR agl’ (center of radiation above ground level) cell. This
places the antenna halfway up the pole.
Obspat defaults most data to safe values, those that will not cause errors. In
this case, the antenna Ref Dir cell has a default direction of zero, or north.
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Note the scaled drawing. Directions and relative distances are reasonably
accurate in this depiction, which may be used to visually verify correct data
entry. Depress the Enter key and a new pattern is computed. The
differences between the two patterns show the effects of side-mounting this
antenna on this pole. Disable the obstacle and recalculate (click GO) the
pattern to get a better feel for the differences.
Change the antenna to an omnidirectional type. This is accomplished by
replacing the antenna name with one of the omnidirectional antenna names
or by starting a new row and using the antenna menu. Disable the original
row and enable the new row. Then, change the pole diameter and spacing.
Notice that many of the resulting patterns are similar to those found in
antenna catalogs listing omni antennas with rod type reflectors.
The above examples have introduced essentially all of Obspat’s major
characteristics. More complex problems are simply extensions of these
exercises with more antennas and more obstacles. Install two more
obstacles and enable them. Give both of them the same height and diameter
as the first obstacle. Place the second obstacle in a direction of 150 degrees
at a distance of 3. Put the third at 210 degrees and a distance of 3. Click
GO. An antenna is now side-mounted on a triangular tower. Now try
changing the antenna distance and direction to get a feeling for the power
of Obspat. Change the frequency ‘FMHz’ and observe the pattern changes.
This latter exercise demonstrates some of the actions taken when trying to
synthesize or fine-tune a radiation pattern or solve a radiation problem.
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The distortion of the omnidirectional pattern is startling to say the least.
Now change the antenna’s Ref Dir by 5 degrees by entering either 5 or 355
degrees. The additional changes resulting from this small change in the
antenna’s mounting azimuth are significant and noteworthy.
The final exercise is to substitute a directional antenna for the
omnidirectional one. Again, either start a new row using the antenna menu
or replace the name of the existing antenna with a name for a directional
antenna. Enable the new antenna and disable the old antenna if necessary.
Click GO. The scaled drawing has a short line attached to the antenna
symbol pointing straight up (North). This line shows the direction that the
main lobe of the antenna is pointing, in this case at zero degrees (North).
(Note: Obspat stores all antenna patterns with the center of the main lobe of
an antenna pointed north (zero degrees). Most of the time this corresponds
to the direction of greatest gain of an antenna. Sometimes, however, it does
not. In those cases the antenna physical aiming direction (bore-sight) points
north. Bore-sights can include such things as external elements all facing
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the same direction yielding a directional pattern, even if the main lobe of
radiation is not along the bore-sight. This is the practice employed for most
catalog antenna pattern illustrations.)
Entering a value other than zero in the antenna ‘Pat Dir’ cell will rotate
antenna patterns. Enter a value of 45 in this cell. Note the direction line
shifts to the northeast. Click GO and observe the pattern changes.
A significant percentage of practical radiation problems and antenna
radiation pattern styling may be solved with the techniques learned to this
point. A more complete understanding of Obspat, its functions and its
limitations will lead to solutions of considerably greater complexity and
versatility. For example, incorporating tapered towers, transmission lines,
multiple antennas, non-cylindrical obstacles and a host of other common
issues await your discovery.
7.6
Face-mounting An Antenna, Position Calculator
Tower structures frequently have antennas mounted between a pair of legs,
or, adjacent to the face. Specifying the position of an antenna, which must
be referenced from a leg (obstacle), requires a position calculation to
determine its distance and direction. For example, suppose a triangular
tower has a vertex North with a face South. Assume an antenna is to be
mounted 2 feet from the center of the northwest face. What are the distance
and direction values for the antenna? The answers to this common scenario
are easily found using a special Obspat tool.
After the tower legs have been entered into the obstacle table and enabled,
the face mounting tool may be invoked by placing the mouse cursor in
either the Ref Dis or Ref Dir columns in one row of the antenna table.
While holding down the Shift key, click the mouse button. The following
dialog will appear.
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This dialog requires two obstacle numbers, a distance from the face and a
distance from the leg (obstacle) used as a reference for this calculation. The
reference leg is entered in the ‘First Obstacle No.’ field. The other leg of
the face is entered in the ‘Second Obstacle No.’ field. ‘Distance from a line
between obstacles’ is simply the distance from the face. Distance from first
obstacle is the distance along a line between the first and second obstacles.
The +/- buttons are present to toggle the antenna position to either side of
the line between legs (obstacles). This is sometimes required and is clearly
evident in the scaled plan drawing of the obstacles and antenna. Click the
buttons and observe the results in the drawing. Click the buttons again and
the original values are returned.
When ready click OK. The computed values are automatically entered into
the distance and direction columns of the antenna table, in the row over
which the cursor was placed when the mouse button was clicked.
Additionally, the ‘First Obstacle No.’ field is entered in the Ref column for
that row.

While this example demonstrates a triangular tower, it is perfectly general
and may be applied to any two obstacles. Occasionally, an obstacle is
entered temporarily to compute the position of an antenna with respect to
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another obstacle. The temporary obstacle is then deleted, leaving the
desired distance and direction.
7.7
Obstacle Position Calculator
The method of setting an antenna’s position described in Section 7.6 may
also be used for positioning obstacles. One of the primary purposes for this
computation is, for example, to incorporate transmission lines or climbing
ladders or conduit pipes that occur in the vicinity of towers. The same
dialog is invoked for obstacles when the mouse is clicked while holding the
shift key down and the cursor is over the Ref Dis or Ref Dir columns in the
obstacle table. In this case, whatever row the cursor is over in the obstacle
table receives the Ref, Ref Dis and Ref Dir values.

8

Situations
Central to Obspat’s versatility and utility is the mechanism of Situations.
Any problem, such as the one in the preceding Section, may be saved,
recalled, modified and deleted. Each situation is saved as a file, which has
been given a unique name.
Judicious use of situation names will enable situation files to be related, or
not, as desired. As indicated above, the Situations field on the
Preferences/Selection Criteria page forces the Select Situations pull-down
menu (located above the scaled drawing) to display only those situation
names that match one or more of the comma separated character
sequence(s). For example, a state abbreviation sequence will produce all
situations that contain that case sensitive sequence and exclude those that
do not.
8.1
Creating
The process of creating a situation is simple. Once a problem has been set
up, a new situation may be created by simply depressing the Ctrl-S (Mac
Cmd-S) keys or using the mouse to select the File>Save menu. A dialog
will appear and request a unique filename. The situation is saved in the
current situation folder. The new situation then appears in the Situation
menu.
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8.2
Selecting A Situation
To select a situation simply choose it from the pull down menu, Select
Situations. The situation as last saved will appear and may be used as if the
data had just been entered.
Double-clicking a Situation file will start Obspat after which the situation
may be selected.
8.3
Saving
Ctrl-S (Mac Cmd-S) or selecting the Save Situation in the File menu will
save any changes made to an open situation. Saving a situation may be
performed at any time. Note that an opened situation will be automatically
saved if the situation name is changed.
8.4
Save Situation As
Save Situation As places a copy of the currently selected situation in the
currently selected situation folder, requiring a name unique to that folder. The
original situation remains unchanged.
This function can only be implemented through the File>Save Situation As
menu item. There must be an existing situation previously selected.
8.5
Changing A Situation’s Name
To change a situation name, select the situation from the pull down menu
and then click the Chg Name button. A dialog will appear asking for a new
name. Clicking Change in this dialog will rewrite the entire situation. This
means that all of the previously made changes to the situation will become
permanent.
If this is undesirable, click the Clear button and the situation will be closed
without saving. Then reselect the original situation and change its name.
Changes made to the original situation will be lost in this process.
If any recent changes made to an open situation need to be retained, the
‘Save Situation As’ option may be used to create a situation with a new
name containing the changes. The original situation, unchanged, may then
be reselected and have its name changed using the Chg Name button on the
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main screen. Save Situation As can also be used to make additional copies
of a situation.
8.6
Note Field
A one-line field, located under the situation pull-down menu, is provided for
any notation desired. This field is printed on data sheets. Editing in the usual
manner will change it. When changed, the situation must be resaved by
selection from the File menu or depressing the Ctrl-S (Mac Cmd-S) keys.
8.7
Deleting
A situation may be deleted by selecting the menu Tools>Delete Existing
Situation. A dialog will seek selection of the file to be deleted. Ctrl-D (Mac
Cmd-D) is the keyboard equivalents for the menu selection.
8.8
Situation Folders
Situation files (having extensions of .ops) may be kept in folders anywhere
on a computer or network. Situations may be grouped in any convenient
fashion. By job, region, state, system, etc. Obspat retains the current
situations folder path in its Preference file. Thus, each user can access
different situation folders and change to other folders at will.
Network access to these folders may require that folders and all contained
files in them have the correct permissions and are shared resources.
Because there can be many Situations folders, it is recommended that a
systematic folder naming method be employed. This mechanism can be a
much more powerful alternative to entering selection criteria in the
preferences. For example, companies with dispersed facilities can easily
forward entire system designs across the Internet by transferring situation
folders. Note that situation files do not contain complete antenna data sets.
Therefore, the receiving end would also require copies of the antenna files
used in the situations.
8.9
Selecting Situation Folder(s)
Select a situation folder by selecting the menu Tools>Select>Situations
Folder. A dialog will appear for folder selection.
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The path to the currently selected situation folder may be viewed at any
time by placing the mouse cursor over the word Sit, located near the Go
and Clear buttons. The path is written beneath the obstacle and antenna
tables. (All of the abbreviations in that Sit column show paths to the current
Obspat operational folders.)
8.10 Print An Internal Situation File
It is unlikely you will ever need this function. It prints a selected Situation
file as internally stored by Obspat. These files hold information selected by
the user including data entered in the obstacle and antenna tables as well as
any print and display options. This function may be selected in the File
menu.

9

Main Screen Controls and Options
There are a number of options, checkboxes and other controls on Obspat’s
main screen. This Section deals with their functions and operations.

9.1
Frequency
Frequency is a fundamental variable. It is entered in MegaHertz in the
upper-right corner field labeled FMHz. Frequency affects every aspect of
Obspat. This may be observed by noticing how a situation changes with
frequency.
Situations stored in Obspat always contain a frequency that is reset each
time a different Situation is selected.
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The preferences file retains the frequency that was contained in this field
when Obspat was last shut down. That frequency will appear in the FMHz
field when Obspat next starts.
Obspat’s default frequency is 100 Mhz. This value will be defaulted when
the preferences file is created or when the Clear button is actuated. When
creating any new situation, get into the habit of entering the frequency
value first.
9.2
Calc Polarization
Obspat can calculate pattern distortions to either horizontally or vertically
polarized waves. The two Calc Polarization buttons, V & H, are selectors
for how Obspat computes the effects. Most practical problems use vertical
polarization, the default.
In typical problems, obstacles are vertically oriented. Antennas are
vertically polarized, meaning the antenna’s electric field is vertical. This
default condition is computed when the Calc Polarization is set to vertical
(V). If changed to horizontal (H) Obspat computes the problem assuming a
horizontally polarized source, or more technically, the antenna’s electric
field is at right angles to the axes of the obstacle(s).
9.3
View Plane
This selects the plane to be displayed and printed. When changed the
pattern must be recomputed.
Typical uses include viewing and printing the vertical plane patterns of
antennas. When View Plane button V is selected, the vertical plane pattern
is printed and is displayed with the horizon represented by the horizontal
axis of the polar plot.
Button H displays and prints as a standard azimuthal plot with North at the
top of the polar graph.
View Plane defaults to the horizontal plane.
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9.4
Ant Pattern Plane
These two buttons select the antenna patterns to be used for computations.
Selecting button H means that Obspat will use for its computations the
horizontal plane patterns of all antennas. Button V selects vertical plane
patterns.
Antenna Pattern Plane defaults to horizontal.
9.5
Warning Indicator
A prominent colored circle appears in the midst of the View Plane and Ant
Pattern selectors. This indicator has three states; green, yellow and red.
Certain combinations of the four View Plane and Ant Pattern Plane buttons
select situations that are impossible causing the indicator to be red.
Questionable combinations requiring greater user attention and caution are
yellow. Selected combinations with no questionable issues are green.
Only a red indicator causes Obspat to refuse to compute. Yellow allows full
computation but warns that results should be carefully verified for
correctness.
An example of a yellow situation is where a normal horizontal plane
pattern is desired, but is utilizing the vertical plane pattern of an antenna.
Issues such as this may occur when using antennas that may be capable of
more than one polarization or physical orientation, such as a yagi, which
can be rotated to a horizontal or vertical position.
9.6
Include V Plane Pat
After a problem or situation has been satisfactorily computed, it may be
desired to create an antenna file so the results can be used in another
application such as a program to compute coverage. Frequently, a vertical
plane pattern is required in addition to the horizontal plane pattern.
When selected, this option enables a vertical plane pattern to be included in
the antenna file. This option is effective only when the computed pattern is
to be saved as an antenna through selection of the menu File>’Save Sit
Pattern As Antenna’.
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Note that this option restricts the user’s choices for vertical plane data to
one of the antennas used in the calculations. The selected vertical plane
pattern data is appended unmodified to the new antenna file. (There are
other means available in Obspat to generate and store vertical patterns.
However, this option is a quick and accurate method in some instances.)
When using a single antenna, this technique provides relatively accurate
results because, for many cases, the vertical plane pattern is little changed
in the presence of obstacles. This is particularly true when obstacles have
small dimensions in the antenna’s electric field plane. For example, a
vertically polarized antenna side-mounted on a tower provides considerable
distortions in the horizontal plane pattern but only small distortions in the
vertical plane pattern. (For horizontally polarized antennas, an antenna’s
horizontal plane electric field produces great changes to the vertical plane
pattern and few disturbances to the typical horizontal plane pattern because
there is less metal in the horizontal plane.)
If the problem involves two or more interacting antennas, this technique
becomes somewhat problematical. Interacting antennas with different
vertical plane patterns or operating at different elevations will produce
vertical plane distortions. It has been found that under these circumstances
using the vertical plane pattern of the antenna with the greatest vertical
plane gain is often a useful approximation.
9.7
Include Expanded (Pattern)
When enabled, this option causes Obspat to display low pattern values
magnified (expanded) by some factor. For patterns expressed in dB, the
expansion is 20 dB. Field patterns are expanded by a factor of 10.
Patterns are displayed on polar graphs. This type of graph loses detail for
low values occurring near the graph center. Selecting this function will
cause an extra line to be displayed where pattern values drop below a preset
threshold level. These lines are displayed and printed.
Note: Sometimes the additional lines are inaccurately displayed. This can
occur when pattern values drop below the threshold and then rise above the
threshold in less than three degrees azimuth (or elevation). Obspat
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computes patterns in one-degree increments and cannot accurately display
the necessary expanded line segments. This does not affect accuracy nor
does it occur frequently in practice.
9.8
Composite (Patterns) And Envelope Only
There are times when it is desirable to view collections of antenna patterns.
Selecting the Composite option causes Obspat to display and print the
patterns of more than one antenna. This feature is frequently used to obtain
the overall radiation characteristics of multiple antennas.

Warning: This feature should be used only for antennas that are noninterfering, for example, using antennas operating on different frequencies.
Antennas that operate on the same frequency, such as those configured in
an array, are the normal case in Obspat and must be computed with
Composite and Envelope Only options disabled.
A simple example is a cellular system sector antenna arrangement using
any three antennas positioned at 120-degree intervals. Obspat can display
simultaneously (and print) the three antenna patterns.
When selected, this option causes the Envelope Only checkbox to appear.
If Envelope Only is enabled, only the greatest (outermost) gain values are
displayed and printed. This has the effect of eliminating lower level details
and shows the maximum gains expected from the combined antennas.
Obspat considers power divisions or differences in power levels of the
antennas as specified by values entered in the Power column of the antenna
table. It also includes each antenna’s pattern orientation.
Patterns produced using this option may be saved as antennas and have
vertical patterns appended as discussed in Section 9.6.
A more complex example would be to study the effects of obstacles on a
group of antennas. This may be accomplished by breaking the problem into
the same number of parts as there are antennas. For example, set up a
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situation with one antenna and the obstacles that are in the antenna’s
aperture. Compute the pattern with Obspat and store the pattern as an
antenna using the menu File>Save Sit Pattern As Antenna. Repeat this for
each antenna. Then create a situation comprised of a collection of those
saved patterns with the Composite option selected. Selecting the Envelope
Only option yields the combined obstructed envelope pattern from that site.
Saving this pattern as an antenna gives a pattern that may be used in a
coverage prediction application. This is a very useful and powerful feature
of Obspat. Often showing very unexpected problems.
9.9
Cursor Pattern Values
While any pattern is displayed on the screen, moving the mouse cursor in
the plot area causes the azimuth and pattern gain to be displayed to the
right of the words Azimuth and Gain, respectively. This provides a handy,
fast method to review pattern values during times when the user may be
changing various data. For example, when attempting to synthesize a
pattern or trying to find an antenna mounting distance and angle to achieve
a desired pattern result.
This feature is disabled when the Composite option is selected without the
Envelope Only option due to Obspat being unable to display more than one
gain value per azimuth. The feature is enabled for composite envelope
patterns.

9.10 Max, Min
These two rows, located under the cursor pattern values, also display
azimuth and gain.
Max shows the pattern azimuth and gain values where the pattern first
reaches the maximum gain, starting from zero degrees.
Obspat Instruction Manual

33

Min shows the pattern azimuth and gain values where the pattern first
reaches the minimum gain, starting from zero degrees.
9.11 RMS
Engineers for many reasons frequently use this value. It is expressed in
Obspat in the units of the displayed pattern. (E.g. dBd, dBi and Field,
including relative values.) The best understanding of the usefulness of
RMS will come from knowledge of how it is calculated and what it can
indicate.
Obspat combines absolute field gains of an antenna as modified by losses
(power division), current phases, pattern orientations and relative position
to derive a single pattern. RMS is computed by extracting the square root
of the sum of the squares of the gains at each azimuth divided by the
number of gain values. This yields a gain value that represents an
omnidirectional equivalent of the displayed pattern. The value is then
converted to the displayed pattern units.
Examples of some RMS values should make this a little clearer. An
antenna with an omnidirectional radiation pattern having a gain of 10 dBd
has an RMS value of 10 dBd. This occurs because there are no variations in
the pattern. An antenna with any pattern variations will always have an
RMS value less than or equal to the maximum pattern gain.
A common Obspat case has an omni antenna side-mounted on a tower leg.
Typically, even when the omni pattern is grossly distorted with deep nulls
and sharp maxima, the RMS value of the distorted pattern is within a few
tenths of a dB of the omni gain of the antenna. This indicates that the
pattern calculation is accurate and that the pattern distortions are not
appreciably degrading antenna efficiency. Stated another way, the sum of
areas of all the pattern variations greater than the RMS value equals the
sum of the areas of all the pattern variations less than the RMS value.
(Incidentally, the usual reason for any discrepancy between the antenna
gain and the computed RMS values has to do with Obspat’s calculation
interval of one degree. Smaller intervals would produce smaller
discrepancies.)
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When combining a series of antennas, possibly with one or more obstacles,
the RMS can also be used to judge the efficiency of the arrangement.
Certain separation distance, direction and current phase values can reduce
the combined pattern RMS. Depending on the nature of the problem, all of
the data parameters can be adjusted to provide the greatest RMS value
indicating the greatest efficiency.
9.12 RMS Adjust
Selecting this button normalizes the computed pattern rms to have the same
value as the set of antennas operating without obstacles. Obspat first
computes the rms of all antennas. Then it computes the rms of all antennas
and obstacles. If the latter value exceeds the former by more than 1 dB each
pattern value is reduced by the rms difference. Thus the pattern shape is
unaffected, only the pattern magnitude is changed.
This is useful when, due to a large number of (and/or close spaced)
obstacles and/or antennas, the computed rms increases to incorrect levels.
If the pattern gain or rms values appear incorrect, this option should be
selected. Note that no corrections are made for pattern rms values less than
the antenna-only rms because lower values indicate a drop in efficiency.
If uncertain about using this option, compute the pattern both with and
without the option. If the two rms results are about equal this option is
unnecessary.
9.13 Clear
This button resets the main Obspat screen. It also reinstates Preferences
that were present when Obspat was opened. Any needed Situation,
information or changes should be saved prior to clicking the Clear button.
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9.14 Go
This button instructs Obspat to calculate or recalculate a pattern. The GO
button operates only when at least one antenna has been specified and is
enabled. There is no requirement for obstacles to be specified. Any data
changes require the Go button be clicked to obtain a new pattern.
If one antenna only is enabled, Obspat plots the antenna pattern. The view
plane is then used to select the horizontal or vertical pattern. This pattern
may be plotted and printed using any output units.
If two or more antennas are enabled with no enabled obstacles, Obspat will
compute the pattern using all the parameters entered on the antenna rows.
This process is essentially a free-space combining or synthesis of multiple
antennas.
9.15 Clear Row
This function resets a row to empty. The two Clear Row buttons beneath
the tables operate independently on the tables above them. To clear a row,
mouse-click the desired row in the first column containing the enable
checkbox. The click should be made outside the checkbox but inside the
checkbox cell. This selects the entire row. Then click on the Clear Row
button.

9.16 Add Rows
Obspat initializes with 10 rows in each table. If more rows are needed, each
click of the Add Rows button adds five rows. These buttons also operate
independently on the tables above them. There is no limit to the number of
antennas or obstacles except as imposed by hardware.
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10 Antenna Processes and Files
This Section covers the mechanics of antenna data, antenna data files and
the processes used for managing antennas. It describes functions and
controls found on the main antenna screen with the exception of the Export
button, which is described in a separate Section.

The Obspat antenna screen may be invoked by starting Obspat. If it is
desired to open an existing antenna file select the menu File>Open
Antenna. If it is desired to hand enter data for a new antenna, select the
menu Tools>Antenna>New. The antenna main screen appears.
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Most of the fields in the screen are self-explanatory. However, this Section
will discuss each field and add some practical hints and suggestions for
efficient use. Any Obspat antenna file may be reviewed and altered in this
screen.
To save changes made to fields or data in an opened file, use the menu
File>Save Antenna or click on the Save button before the Cancel button.
The Cancel button closes the antenna screen without saving.
Antenna files having non-Obspat formats may be also be altered by
importing an antenna pattern into Obspat, making changes and then
exporting the pattern back to the original format.
Note that not all formats support all Obspat antenna fields. Nor does
Obspat support all fields in some formats. In either case, the desired
information may also be entered to a formatted file using a text editor,
without going through Obspat.
10.1 File Name
This name is important and must be unique in the currently selected
Antenna folder, unless an existing antenna is to be replaced. To this name
Obspat adds an extension (.opa) that becomes the complete antenna file
name. Do not include a file extension in this field.
This name appears in the antenna menu and should be helpful and not
confusing, if possible. As with situation names, it is recommended that a
descriptive filename be used, particularly if several variations of the same
antenna are to be used. A single omni antenna for example may have
several patterns, one for each value of electrical beam-tilt.
10.2 Manufacturer Name
This name or abbreviation appears in the list of manufacturers on the
Preferences>Selection Criteria page. Since this list shows all
manufacturers, a typographical error could cause a wrong name to appear.
Sometimes imported antennas have different names, even from a
manufacturer. This field may be changed easily by editing the antenna file.
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10.3 Freq Min Mhz And Freq Max Mhz
These fields define the frequency range of the antenna in Mhz. A value
only in the Freq Min MHz field indicates the antenna is available or will
work at or above the given frequency. Similarly, a value only in the Freq
Max MHz field defines the upper limit.
10.4 Measured or Pattern Freq MHz
This field is the frequency at which the data was measured. If none of the
three frequency fields contains a value, Obspat will assume the antenna is
available and can work at all frequencies and it will not be culled from the
antenna menu using frequency.
10.5 Model, Description, Note And Comment
These optional fields are general purpose and may contain any useful
information or notes. They may be empty.
10.6 Mfr ID and FCC ID
These two optional fields relate to ‘official’ identifications assigned by the
manufacturer and the U.S. Federal Communications Commission. Both
typically have some connection with a government or regulatory agency.
Frequently, antennas that are well known may be given a number
indicating it has been type accepted.
10.7 Available Polarization(s)
Some antennas are capable of using different polarizations. This field uses
comma separated polarization designations. For example, a Yagi antenna
may be mounted vertically or horizontally. The field could then contain the
characters v,h. Polarization designations may consist of any character
sequence.
However, when culling antennas by polarization for display in the antenna
menu, Obspat performs a search of this field using a character matching
technique. For example, suppose the letter v was entered in the Polarization
field of the Selection Criteria page of Obspat Preferences. This letter is
compared against all of the letters or groups of letters listed in this field. If
a match occurs, the antenna is added to the menu. If no match is found, it
will not appear in the menu.
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10.8 This Polarization
This field identifies the polarization of the antenna. It must consist of one
and only one polarization identification, either a single letter or group of
letters.
This field is used to cull the antenna menu.
10.9 Entering Pattern Data - General
Data may be entered in either or both the horizontal and vertical planes.
The following information relates to both planes. There must be at least one
azimuth-gain pair entered for one plane.
Units for Azimuths are selected using the pull down menus in the Antenna
screen. Possible units are degrees and radians.
Units for Gains may be dBd, dBi or Field as selected in the Gain Units pull
down menus.
Relative units may be entered directly by selecting the Relative checkbox.
When selected, a field appears in which the maximum antenna gain is to be
entered in the units specified by the Gain Units menu.
Azimuth values are entered followed by a Tab (to the Gain field). After
entering a Gain, another Tab will move the cursor back to the Azimuth
column in a newly created row.
10.10 Entering Pattern Data – H Plane
Obspat’s horizontal plane patterns are displayed and printed with North (zero
degrees) at the top of the screen or printed page. Clockwise rotation advances
from zero degrees to 360 degrees.
When entering data directly into the horizontal pattern table, it is not
necessary to place the azimuth-gain pairs in any particular order. Obspat will
sort the entries in azimuth order.
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10.11 Entering Pattern Data – V Plane
Obspat vertical plane patterns are displayed with an antenna’s main lobe
toward the right on a polar graph, the horizontal axis representing the
horizon. Rotation clockwise (from the right) proceeds below the horizon to
180 degrees, then above the horizon to 360 (zero) degrees.
When entering data directly into the vertical pattern table, it is not
necessary to place the elevation-gain pairs in any particular order. Obspat
will sort the entries in azimuth order. So, if you miss entering an azimuthgain pair, simply write it at the end of the list.
10.12 Entering Pattern Data – Beam Tilt
This field is the angle in degrees below or above the horizon at which the
electrically altered vertical plane pattern reaches its maximum value.
Obspat does not use the beam tilt value. Values in this field typically arrive
in certain imported file formats but also may be entered from the keyboard.
The values for beam tilt are positive for down-tilt (below the horizon) and
negative for up-tilt (above the horizon).
10.13 Miscellaneous Data
The following fields are listed but not used by Obspat in its calculations.
Data for these fields generally is taken from imported files and may have
inconsistent meanings. The data is principally used for import/export
purposes and for culling antennas displayed in antenna menus.
Antenna length/height in meters. If unknown this field may be left empty.
In general, antenna length is a function of frequency. Therefore, this value
may or may not represent the antenna length called for in the ‘Ant len’
column of Obspat’s main screen antenna table.
Width/Diam in meters. This field can be either Width or Diameter.
Depth in meters.
Horizontal plane half-power beam width in degrees.
Vertical plane half-power beam width in degrees.
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10.14 Cancel
Any time this button is clicked the Antenna Window is closed without
saving. The main screen then appears.
10.15 Save
This button saves in the current Antenna folder the data being displayed on
the screen. If an existing antenna, the old antenna is written over. If the
screen holds a new antenna, or, if the File Name has been changed, a new
file is created.
10.16 Add H Pat And Add V Pat
These buttons permit the addition of antenna patterns currently stored in
Obspat to be added to an antenna file displayed in the main antenna screen.
Add H Pat places a filed antenna pattern, selected in a dialog, in the
horizontal plane table. Add V Pat places a filed antenna pattern, selected in
a dialog, in the vertical plane table.
Non-Obspat antenna files may first be imported into Obspat and then have
a vertical or horizontal pattern appended before saving as an Obspat
antenna file.
Note that this process allows either plane pattern (V or H) of a selected
antenna to be placed in the desired plane.

11 Creating An Omnidirectional Antenna
Omni antennas may easily be created in Obspat. Start Obspat and select
menu Tools>Antenna>New. The Antenna screen appears.
The minimum data necessary consists of a File name and one azimuth-gain
pair.
Click the Save button and the new antenna is created and added to the
antenna list. It may not appear in the list if it does not meet the antenna
selection criteria specified in the Selection Criteria page of the Preferences.
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During the creation process, if no azimuth-gain pairs were entered for the
other plane, Obspat will inquire if the user desires Obspat to estimate the
other plane pattern. Click yes or no.
Obspat creates the other plane pattern using the omni gain of the antenna as
a starting point. For example, an omni gain of zero dBd in the horizontal
plane will compute a vertical plane pattern of a single vertical half-wave
dipole. If the omni gain is 3 dBd, two vertically stacked vertical dipoles
will be used to compute the vertical plane pattern.
Any patterns generated by Obspat should be reviewed using the main
screen. If Obspat generates an incorrect pattern, select the antenna using the
menu File>Open Antenna. Then click the Store button and answer No to
the pattern generation question.

12 Creating An Isotropic Antenna
An Isotropic antenna is a theoretical antenna postulated by engineers as a
reference. It is not physically realizable. Obspat freely uses such a
reference. The pattern of an isotropic antenna would be a sphere in three
dimensions. In Obspat, a sphere is represented by a circular pattern in both
the horizontal and vertical planes. An Isotropic antenna has no polarization.
Obspat creates an isotropic antenna slightly differently from an omni
antenna. Select from the menu Tools>Antenna>New and enter a file name.
In one plane enter one azimuth-gain pair such as 0,0. In the other plane,
enter two azimuth-gain pairs with different azimuths but having the same
Gains. For example, 0,0 and 90,0. (This is required because Obspat treats a
single azimuth-gain pair as an omni pattern and does not permit both planes
to be omnidirectional. By entering two azimuth-gain pairs the interpolation
routines are tricked.)
Normally, isotropic references have a unity (1.0) field gain, which is zero
dBi. (There is no reason that other gains cannot be used, if desired.)
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With respect to an isotropic reference, the gain of a half-wave dipole is
approximately 1.64 in field, which is 2.15 dB. A half-wave dipole reference
is the historic reference used in the antenna industry because dipole
antennas can be measured and any other measurable antenna can be
referenced to the half-wave dipole. Obspat converts and stores internally all
antenna data in dBd. Most computations, however, are performed internally
using Field values. Thus, when viewing an isotropic antenna after its
creation, the field values are 0.776, the dipole dB values are –2.15 and the
isotropic dB values are zero.

13 Importing Antennas
A number of different antenna file formats may be imported into Obspat.
Importing is the process of reading an antenna file in some format and
converting as much information and data as possible from that file. The
information is then stored as an Obspat antenna. This process is easily
implemented in Obspat.
13.1 Import Folder
To simplify the process, Obspat imports files from a folder reserved for that
purpose. To select an import folder, choose from the menu bar Tools>
Select Data Folder> Antenna Import Folder. A dialog will request the
location of the desired folder. (Recall that the Desktop is a folder.) Once
selected, a folder becomes the default until another folder is selected.
The folder name and its location can be observed anytime by moving the
mouse cursor over the Imp characters to the left of the scaled diagram on
the main Obspat screen.
13.2 Import Operations
To import an antenna select from the menu Tools> Antenna> Import
Antenna File(s). A dialog will appear requesting the specific format (in a
drop down menu) and displaying two option selectors.
The first option, Query Before Writing, causes each imported file to be
displayed in the antenna main screen. This enables the user to add, change
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and delete the imported data. The data may then be stored by clicking the
Save button or rejected by clicking the Cancel button.
If the current import folder contains more than one file and batch
processing (described next) is not selected, a dialog will appear requesting
the user to identify the file to be imported.
13.3 Batch Imports
This option enables batch import conversions if several conditions are met.
First, all of the files to be imported in the current import folder must have
the same format. Any folder, temporary or otherwise, may be used as a
batch import folder.
Batch processing can proceed with or without the files being displayed on
the main antenna screen. However, the process will flow through the main
antenna screen if either the Query option is selected or if missing
information is detected.
Duplicate antenna file names will evoke a dialog forcing the user to resolve
the duplicate, overwrite the existing file or to bypass a file without saving
it.
13.4 Importing Dual File Formats
Some antenna formats have separate files for horizontal and vertical plane
patterns. Obspat handles these as automatically as possible. When the
current import folder has more than one file pair and batch processing is
not selected, the user must identify the files for each plane in separate
dialogs.
When batch processing is selected and the Query Before Writing option is
deselected and there is no missing important data, the batch process will
proceed without intervention.
Note that Obspat also permits importation of a single plane. For example, if
only the vertical plane pattern is desired, when the dialog appears
requesting selection of the horizontal plane pattern, simply click the Cancel
button. The following dialog then requests selection of the vertical plane
file. When that antenna is saved in Obspat, it will have only a vertical plane
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pattern. Once in Obspat, this pattern may be added to or substituted for an
existing antenna vertical pattern. See Section 10. Similar considerations
apply to the horizontal plane.

14 Exporting Antennas
Obspat antenna files may be exported in a number of antenna formats,
including both single and dual file formats. Exporting is the process of
converting Obspat antenna files into antenna files that can be read by
applications using a variety of formats. The conversion is format specific
and selectable. Exported files are placed in the current Export folder.
To select an export folder, choose from the menu Tools>
Select Data Folder> Antenna Export Folder. A dialog will request the
location of the desired folder. (Recall that the Desktop is a folder.) This
folder becomes the default until another is selected.
The folder name and its location can be observed at any time by moving
the mouse cursor over the Exp characters to the left of the scaled diagram
on the main Obspat screen.
Only one file may be exported at a time.
14.1 Export Operation
To export an antenna, open the antenna file by selecting File> Open
Antenna from the menu. A dialog will request the user select the antenna
file to be exported and place that file in the antenna main screen. Then click
the Export button on the antenna main screen. This will evoke a dialog
requesting the specific format. The exported file will be placed in the
currently selected export folder. After the file has been written, dismiss the
antenna main screen by clicking Cancel.
Information required by some formats may be missing from the Obspat
pattern file. This is typically due to the data not having been present when
the original file was imported into Obspat. Once the export antenna has
been selected and appears in the main antenna screen, data may be changed
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or added as necessary. When the Export button is clicked all screen data
required by a particular format is written to a file.
If during this process some new or changed screen data is to be saved, click
the Save button. Otherwise click the Cancel button to dismiss the antenna
screen without saving.
Important missing information required for a format may be added to the
exported file using a text editor. However, a thorough knowledge of the
format is necessary.

15 Mathematics Of Obspat
Obspat is based on series solutions of Maxwell’s equations. Obstacle
reradiation is computed for each antenna–obstacle pair by computing the
obstacle reradiation magnitude and phase using distance and direction
between the antenna–obstacle pair and antenna gain in the direction of the
obstacle. When every obstacle’s pattern has been computed they are
vectorially combined with the patterns of all antennas as modified by
antenna power percentages, user specified antenna phase delays, pattern
gains, pattern orientations and geometrical spacing and directions.
Obspat also computes a factor for each antenna–obstacle pair based on
antenna length and obstacle height. This factor uses the Fresnel integral to
modify the pair gains and is determined by vertically segmenting the
antenna into one-wavelength parts and comparing the center height of each
part to the height of each obstacle. The average of all the parts yields a
factor that modifies the magnitude of the antenna-obstacle pair gains
yielding, for example, correct results when the antenna is only partially
obstructed by an obstacle.
For angles near the horizontal plane, the predominant effects of an obstacle
on an antenna pattern occur over a distance of approximately one Fresnel
zone below the antenna aperture to one Fresnel zone above the antenna
aperture. Outside this range the obstacle has minor effect on the final
pattern. Thus, it is necessary to specify only the height of an obstacle.
Obstacles that begin and end within an antenna’s aperture may be treated as
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though they begin at the bottom of the aperture and extend into the aperture
only their own length. Those obstacles are entered as having an overall
height equal to the height to the bottom of the antenna aperture plus the
length of the obstacle in the aperture of the antenna. This is equivalent to
simply entering the height to the top of an obstacle.
15.1

Simplified Mathematical Overview

Assume
ß = 2π/ λ

where λ = wavelength.

FAO

Fresnel factor for each obstacleantenna pair. A function of antenna
€
center height, antenna length and
obstacle height.

€

x = ßa

where a = obstacle radius.

Jn(x)

Bessel function of order n.

Hn(x)

Hankel function of order n.

Then
2
∞
& J 2 ( x)
)
n Jn ( x)
0
ObsAO (φ ) = M (φ ) (
+ 2 ∑ (−1)
cos( nφ ) +
Hn ( x)
' H0 ( x)
*
n=1

∠ ( C + ∠ObsAO (φ ) − β dAO cos(φ ) + Phase)
€

where AO = antenna-obstacle pair,
Ø = azimuth, dAO = distance between
illuminating antenna and obstacle,
∠ = angle, Phase = user
specified phase delay of illuminating
antenna, C = constant.

€

€
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Where
F
M (φ ) = P•ga(φ ) • AO
π

% λ (1/ 2
•'
*
& dAO )

where P = % power to illuminating
antenna, ga(Ø) = antenna gain, FAO =
Fresnel factor, dAO = distance
Between illuminating antenna and
obstacle.

€

Ant j (φ ) = P j •ga j (φ ) ∠ (β d j cos(φ ) + Phase j )

Where j = antenna number
P = % power, ga = antenna gain,
dj = distance from reference point,
Phase = user specified phase delay,
∠ = angle.

€

Finally, each of the above patterns are combined vectorially as

€
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$
'
Pattern(φ ) = ∑& Ant i (φ ) + ∑ Obsij (φ ))
)(
%
i=1 &
j=1
na

where na = number of antennas,
no = number of obstacles.

€

16 Limitations
This Section discusses limitations of Obspat. In the two decades of learning
how best to use Obspat, these limitations have existed. Even with these
limitations Obspat has solved or aided in the solution of more than ninetyfive percent of common antenna issues and problems. Furthermore, Obspat
has successfully been used to synthesize thousands of antenna array
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designs for such diverse uses as broadcast, paging, two-way and cellular
systems.
Other Sections discuss mitigations to a number of these limitations.
16.1 Antennas
• Antenna files are limited to pattern values in the horizontal and vertical
planes only. Each plane pattern has a limit of 360 points giving a resolution
of one degree in azimuth and elevation.
• Number of antenna files accessible in Obspat is limited only by hardware
memory.
• Obspat problems have no practical antenna number limitation except as
limited by computer memory.
16.2 Obstacles
• Number of obstacles is limited only by hardware memory.
• Obstacles are considered to be vertically oriented right cylinders of
arbitrary diameter. Later Sections will show that different cross sectional
shapes may be used with some adjustments in physical dimensions. The
use of non-vertical obstacles such as diagonal guy wires will also be
discussed in another Section.
16.3 Computations
• Secondary effects are not calculated. Most of the time secondary effects
are small. However, in some instances secondary effects could fill or create
low-level nulls. Secondary effects may be conceptualized as reradiation
caused by other reradiation. For example, antenna radiation produces
circulating currents in a metallic object causing the obstacle to radiate
energy, termed reradiation. If the reradiation itself induces currents in
another obstacle, some small amount of secondary reradiation will occur in
those obstacles, which is not computed by Obspat.
• Approximations using infinite series produce inaccuracies in the
computations when antenna-to-obstacle distances are small and when
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obstacles are electrically large. To prevent inaccurate solutions Obspat will
refuse to calculate if the following inequality is not satisfied.

dAO
λ

# Dia & 2
< 2.2 %
(
$ λ '
where dAO = antenna to
obstacle distance, λ =
wavelength, Dia = obstacle
diameter.

€

€
When the inequality is satisfied, Obspat provides accurate results.
• Mixed polarizations cannot be used. Obspat works with one user selected
polarization. That means that both horizontal and vertical polarizations
cannot be used in the same problem. (Horizontal or vertical problems are
acceptable.) Since Obspat can use either V or H plane patterns the program
is essentially blind to the polarization designations, permitting the use of
either plane pattern in any calculation with polarizations selected by the
user.

17 Some Necessary Concepts
Most of this Section is presented to lay a foundation for understanding
subsequent Sections.
17.1 Antenna Aperture
This is simply some length over which an antenna radiates (or receives)
energy. It is easier to visualize the radiating of energy but all concepts here,
by the theory of reciprocity, apply equally to the receiving of energy.
We start with a simple vertical dipole. For our purposes, the dipole has a
height that is its approximate aperture in the vertical plane. It also has a
small width that is its approximate aperture in the horizontal plane.
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More complex antennas may be comprised of combinations of elements
that establish their apertures in both the horizontal and vertical planes. For
example, two vertical dipoles may be stacked collinearly (one directly
above the other). This has the effect of increasing the aperture in the
vertical plane but not in the horizontal plane. Similarly, two vertical dipoles
may be placed side-by-side to produce an increased horizontal plane
aperture with no change in the vertical plane aperture. Before we get into
the why of changing apertures, we need to understand how patterns are
summed or combined.
17.2 Sine Waves And Their Sums
Radiation may be thought of as waves, much as the waves in the sea, with
periodic crests and troughs. Assume two sources, each creating waves. As
those waves radiate outward, they ultimately become smaller amplitude
waves at some distant point. Such repeating waves are called sine waves. If
two sources create waves having the same distance between crests (and
troughs) the waves are said to have the same frequency. The distance
between crests (or troughs) is called the wavelength and is measured in
various units such as meters or feet.
The distance between the source and the receive point determines where in
the periodic cycle of crests and troughs a receive point is located. If the
receive point is situated where, at the same time, crests occur from two
sources, the waves combine to form a wave that is twice that of one source
alone.
In a mathematical sense the sine waves are considered to undulate above
and below a zero reference, located mid-way between a crest and trough,
with the crests having positive values and troughs having negative values.
Sine waves are divided into 360 degrees by convention. There are 360
degrees from crest to crest or from any arbitrary point of one sine wave to
the same point in the next or preceding sine wave.
Sine waves may be added by summing the amplitudes of each sine wave at
every point in its cycle. If two sine waves, each having a maximum
amplitude of one are summed; when in-phase the maximum amplitude
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would equal two, when out-of-phase (180 degrees), the amplitude is zero
and when 90 degrees out-of-phase the maximum amplitude equals one.
There are two principal methods to alter the phase of a sine wave. One is to
physically reposition the source. If the wavelength of a sine wave is one
foot, then moving the source away from a receiving location by 6 inches
would delay the arrival of the wave by one-half wavelength, or, 180
degrees. Similarly, repositioning 3 inches would produce a phase difference
of 90 degrees.
The second method changes the phase using electronic components or
transmission lines. The former may consist of inductors and capacitors. The
latter could delay a sine wave by extending the length of a transmission.
For example, two identical antennas are fed in-phase, equal amplitude sine
waves via transmission lines. If the transmission lines are of equal length
the energy radiated from the antennas will be in phase. If one transmission
line is lengthened by one-half wavelength, the energy radiated from the two
antennas would be 180 degrees out of phase along a line extending through
the two antennas. (Transmission lines used for delay must account for the
velocity of propagation within the transmission line, which is typically
slower than propagation in the atmosphere. This means that the length of
transmission line needed to delay 180 degrees is shorter than one-half of a
signal’s length in air.)
17.3 The Antenna Pattern
In the simplest terms an antenna pattern is a representation of the energy
radiating characteristics of an antenna. It is a display intended to convey a
visualization of where energy is radiated. But, in most cases it is an
incomplete representation.
Energy is radiated in all possible directions from every antenna, more in
some directions than others, but nonetheless in all directions. Typical
antenna patterns show radiation in two principal planes, horizontal and
vertical. Missing are patterns for all other planes. Radiation patterns show
the magnitude of the radiated energy and are usually silent on phases. Is
this an acceptable situation? The answer is yes. No additional information
is required for most practical situations. If it were, the information would
be included in pattern descriptions at a great increase in complexity and
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required interpretive skills. For even demanding situations, however, the
present practice of displaying antenna patterns is sufficient.
Energy radiated from an antenna is in the form of sine waves. The antenna
pattern shows the direction and magnitude of this energy. There are several
common types of antenna patterns, distinguished by how the energy
magnitudes are displayed. For example, there are different units such as
decibels (logarithmic) and field (linear). Information concerning the
antenna’s gain is implicit in the antenna pattern. For example, the antenna’s
gain may be referenced to a half-wave dipole, a practical, easy to measure
reference, or, an isotropic radiator, a theoretical, physically unrealizable
radiator. Each type of pattern has its strengths and weaknesses. (Obspat is
fluent in all these pattern types.)
17.4 Changing Aperture Changes Gain
All antennas have apertures in the planes described by typical horizontal
and vertical plane antenna patterns. A simple vertical dipole has a narrow
horizontal plane aperture and a larger vertical plane aperture.
Increasing the effective aperture of any antenna increases its gain. The term
effective aperture is used to indicate the antenna’s aperture when
comprised of more than one element or antenna. Here we drop the word
effective and use the term aperture to mean the length of the radiating
portion of an antenna with a single element or collection of elements.
The horizontal plane pattern of a half-wave vertical dipole is a uniform
circle, which indicates a constant energy magnitude radiated in all
directions. The vertical plane pattern is as shown. Notice the gain is 0 dBd,
representing the energy radiated with respect to a half-wave dipole.
(Henceforth, gain is freely substituted for the term energy or energy
magnitude.)
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Increasing the aperture in either plane will increase the gain of the antenna.
In the vertical plane this may be accomplished by collinearly (one directly
above the other) stacking two half-wave dipoles. Since it is desired to
obtain the combined pattern gain, a single power source and a power
divider is used to send equal power to the two antennas. This doubles the
power gain at the horizon. (In dB, doubling the power increases gain by 3
dB. (10 log10(2) = 3).
The pattern in the horizontal plane is still uniform in all directions and 3 dB
greater. But the vertical pattern has narrowed, essentially by redirecting
energy normally radiated above and below the horizon to the region closer
to the horizon – just where it is needed. Shown are the patterns for the
single and dual dipoles. Notice the energy that was present in the single
dipole case at about 30 degrees above and below the horizon has been
redirected in the dual dipole case, resulting in greater gain at the horizon.

The antenna’s increased aperture in the vertical plane accounts for this
increased gain.
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Similar considerations apply to horizontal plane patterns. For example,
placing the vertical dipoles side-by-side will increase the antenna’s aperture
in the horizontal plane. The results of that are shown. The pattern is no
longer omnidirectional. However, the vertical plane pattern is the same as
for the single dipole shown above because the vertical aperture is
unchanged.

Here, instead of an omni pattern, the pattern has become directional and the
gain has increased by 3 dB due to the increased horizontal plane aperture.
Frequently, antennas having directional patterns in both the horizontal and
vertical planes are combined. The same considerations apply to these
configurations. Increasing the aperture increases the gain and decreases the
beamwidth in the plane of the expanded aperture.
17.5 Aperture Length Versus Gain
The simplest way to increase the gain of an antenna is by adding radiating
elements in either plane. Obviously, the aperture increases as additional
elements are arrayed. Antenna arrays typically have radiating elements
separated from 0.75 to 1.0 wavelength. This represents a good trade-off
between obtaining maximum gain and minimizing deleterious effects of
mutual coupling.
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As illustrated above, increasing the aperture of a single dipole by adding
another doubled the gain. This includes the effects of distributing the power
equally to both dipoles. It also applies to either principal plane.
As more radiating elements are used, the gain will continue to rise. But, the
consequence of increasing gain also produces decreased beamwidth in the
plane being expanded. Eventually a practical limit is reached where it
becomes physically difficult to control structural and operating conditions
of physically large antennas. Beamwidths become so narrow, that minor
flexing of the antenna support structure (tower or building) causes the beam
maxima to deviate from its intended direction. The largest non-parabolic,
arrayed antennas in my memory had aperture lengths of 64 wavelengths.
The radiating elements were slots cut in a steel cylinder of considerable
diameter and strength. The vertical plane half-power beamwidth was on the
order of 0.8 degrees.
Generally, any radiating elements may be used in an array. This includes
simple (such as dipole) and complex (such as log-periodic) antennas, with
or without directional patterns in the plane of interest. The power gain of an
arrayed set of N antennas of the same type is easily computed as
Gain = 10 Log10(N). This statement assumes equal in-phase powers fed to
each antenna and antenna spacing of 0.75 to 1.0 wavelengths. If each
antenna has a gain other than unity, then the overall array gain is the
number of antennas in the aperture plus the gain of one antenna. For
example, stacking two dipoles (gain=0 dB) gives a power gain of
10 Log10(2) = 3 dB. Five stacked dipoles would obtain a power gain of
10 Log10(5) = 6.99 dB. Suppose we want to use yagi antennas each having
gains of 6 dB. If four of these are stacked vertically or spread horizontally,
the arrayed gain becomes 6 dB + 10 Log10(4) = 12 Db
It should be clear that rather simple relations exist between aperture length
and gain. Now observe an antenna as listed in a typical antenna catalog.
What is known about an antenna, for example, with an omnidirectional
horizontal plane pattern and a gain of 9 dBd? First, there are 8 dipoles
inside the casing. Second, the aperture length is approximately 9
wavelengths long, allowing for one-quarter wavelength spaces at each end
of the aperture.
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Finally, it should also be evident that every doubling of the aperture length,
doubles the power gain. Thus, increasing the aperture from 32 to 64
wavelengths yields a net gain of only 3 dB. Clearly, diminishing returns in
the quest for ever greater gains.
17.6 Phase Centers
It is somewhat ironic that after expending some effort to assure readers that
phase information is unnecessary except in critical applications, it becomes
important to explain the meaning of phase centers. In the course of spacing
antennas from each other for combining and synthesis reasons, the distance
always refers to an antenna’s phase center. This is an imaginary place in
the immediate vicinity of an antenna where the phase of the radiated energy
can be considered, or assumed to be zero degrees. The phase center is
typically the zero phase reference point for both horizontal and vertical
planes. In the case of the vertical dipole, for example, the phase center is
located at the dipole feed point. In this simple case the phase center
coincides with the physical center.
In engineering terms, the ‘location’ of an antenna, is the position of its
phase center and may thus be represented by a point source that has a
vertical and a horizontal plane pattern. When specifying the distance
between two antennas it is between the phase centers of the antennas.
Typically, phase centers occur near driven elements. A five-element yagi
antenna with one reflector, a driven element and three directors will have
its phase center at the driving point of the driven element.
A log-periodic antenna, which has many elements, has its phase center
located near the pair of elements that have a pair length closest to one-half
wavelength of the driving signal. This location changes with operating
frequency. Because the antenna’s elements are staggered, the phase center
occurs at the mid-point between the attachment points of the two elements
that are half-wave resonant.
Panel antennas comprised of an array of printed circuit or discrete radiating
elements will have phase centers near their geometric centers. This applies
to both horizontal and vertical planes. If the radiating elements in a panel
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antenna are a series of log-periodic antennas, the phase centers occur as
described in the previous paragraph.
Helical antenna phase centers are also usually at their geometric centers.
When working with physical antennas and the measured results disagree
with predicted values, one should suspect an error in the estimated location
of the phase center. Sometimes location errors are evident by the pattern
shape. Sometimes it is difficult to closely assess the phase center location.
When in doubt, measurements of an antenna’s equiphase contours may be
the only solution.
For the majority of conventional antennas, the phase center may be
estimated with sufficient accuracy from knowledge of the antenna’s
physical construction. In critical cases, such as when attempting to create a
very deep pattern null, the actual installed antennas might need position
adjustments to meet requirements.
If the phase center of an antenna is known to within a one-quarter
wavelength, gain predictions should be accurate within approximately 3
dB. If the phase center is known to within one-eighth wavelength, errors
should not exceed about 1 dB.

18 Operational Experience/Advanced Techniques
This Section illustrates numerous uses to which Obspat has been put in the
past. Obspat was originally created using assumptions that defined its scope
and desired objectives. Some of the techniques of this Section are
departures from those original assumptions, which over time and with
considerable experience, have been successfully employed and have
substantially expanded its scope and utility. Essentially, these expansions
arose because of the need to solve frequently encountered issues. The
expansions grew slowly and safely, being adopted only after checking
predictions against actual results. Experience has shown that many
solutions yield accurate results or, at least, indicate correct trends. For
example, including diagonal guy wires using the procedure described later.
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The information in this Section is believed to yield accurate, practical
results. However, if critical signal levels are required, Obspat’s results
should be field verified, or, a different radiation prediction method should
be employed.
18.1 Specifying Antenna Lengths in Obspat
Antenna lengths as entered in the ‘Ant len’ field, are important when a
problem deals with obstacles that partially occlude only a portion of an
antenna. For example, a large omni antenna side mounted on a tower with
some parts of the antenna above and below the tower top. In Obspat, this
case is handled by entering the height of the obstacles (tower legs), the
center of radiation height of the antenna and its aperture length.
Pattern distortions are generally not very sensitive to aperture lengths. In
practice the overall antenna length that includes the length of the mounting
pipe, as given in an antenna catalog, is often substituted for aperture length.
Experiment with this at various frequencies to gain experience and
confidence using this substitution. As always, for critical cases use the
actual aperture length.
18.2 Specifying Antenna-Obstacle Distances in Obspat
The distance between an obstacle and an illuminating antenna is a very
important factor. The mathematics of Obspat’s method shows a critical
dependence on this distance, particularly for phase angles.
Our experience has shown that the correct distance is from an antenna’s
radiating element (phase center) to the nearest surface of an obstacle.
Radiation patterns as supplied by antenna manufacturers are used most
frequently in Obspat calculations. Often it is difficult to know precisely the
phase center. Estimates of locations are then used, as described in Section
17, above.
If there is some question about an antenna’s phase center location, be
certain to utilize an adjustable mounting system. Then employ
measurements to fine-tune the antenna position to the desired pattern.
Adjusting antenna phases is frequently accomplished using a line stretcher,
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which is simply a section of transmission line that can, by a sliding
mechanism, change its length.
18.3 Tapered Structures And Tapered Components
This Section addresses common elements and conditions that depart from
the original Obspat assumption of obstacles being vertical right cylindrical
structures. It represents the knowledge gained from many experiences with
the program in everyday situations. It is recommended that the user
practice these suggestions in order to better understand pattern limits and
trends as structural shapes are altered. In most cases, observing pattern
changes is easy, simply change a few numbers and click GO.
Towers with tapered faces may be accommodated by using the average
width of a tower’s face taken over the full length of an antenna’s aperture.
As an exercise, it is suggested that users also study individual pattern
results at the maximum and minimum face widths occurring within the
antenna’s aperture. Results of this exercise yield patterns that bracket actual
conditions.
Tapered monopole structures may be treated similarly. Again, as an
exercise, observe pattern differences using monopole maximum and
minimum diameters that occur over the antenna’s aperture.
Sometimes antenna support structures use both tapered legs and faces. The
averages taken over the antenna’s aperture apply here also. It is a good idea
to observe various combinations of the diameter/face width limits to get a
better feel for how these factors affect a pattern. Particularly important are
the interactions between obstacle diameters and face widths. One need only
perform this exercise while learning to use Obspat.
Distances and directions for tapered structures and components may be
obtained by averaging. Tapered structures, for example, have legs
(obstacles) whose distance from an antenna’s aperture changes. Use the
average distance for obstacle-to-antenna values entered for ‘Ref Dis’
columns in the Obstacle and Antenna tables. Similarly, directions entered
into those tables should be entered in the ‘Ref Dir’ columns based on the
obstacle-to-antenna direction from the location of the average distance
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point to the antenna’s phase center. The same considerations apply with
respect to tapered components.
18.4 Polarization and Diagonal Obstacles
The subject of this Section is interesting to those that want to use advanced
techniques or need to refine results for more critical applications. However,
the vast majority of everyday problems do not require use of these factors
and this Section may be skipped.
As with the preceding, learning when particular factors are important is
vital to the mastery of Obspat and in the understanding of how and which
elements impact antenna patterns.
Antenna polarization is traditionally defined as the orientation of the
electrical field vector of a radiated signal. Antennas employing linear
polarizations, such as vertical, horizontal and slant, have electric field
vectors that are constant or fixed with time. Antennas that do not have
linear polarizations, such as circularly or elliptically polarized, have electric
field vectors that rotate with time.
Obspat can calculate pattern distortions under two conditions, when an
electric field is parallel to the axis of a metallic object and when the electric
field is at right angles to an object’s axis. The former may be termed copolarized and the latter cross-polarized.
Since Obspat has been set up to easily and systematically answer sidemounted antenna questions, the normal condition assumes obstacles are
oriented vertically. Antenna polarizations are then selectable as being
vertical (co-polarized) or horizontal (cross-polarized).
Using a simple example of a single obstacle and one dipole, the following
patterns illustrate the large differences typically encountered with co- and
cross polarizations. The more disturbed pattern is the co-polarization case.
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The above patterns may be interpreted in a number of ways. For example,
if an antenna is vertically polarized, then the left pattern shows the reaction
to a vertical obstacle and the right one the reaction to a horizontal obstacle.
If the antenna is horizontally polarized the obstacle orientations are
reversed. (The patterns were produced by alternately selecting the vertical
and horizontal calculation polarization (Calc Polarization) options at the
top of the main screen.)
Obstacles that are oriented somewhere between horizontal and vertical will
affect the pattern somewhere between the left and right patterns. These
patterns actually form bracketing limits for diagonal obstacles. When
treating diagonal obstacles one may obtain a visualization of the trend of
pattern disturbances. (Trending is a useful technique that may be employed
to observe or determine other effects. This will be discussed further under
the topic of oversized obstacles.)
The degree to which an obstacle affects a pattern depends most on the
amount of metal occurring in the direction (plane) of the antenna’s electric
field. A tower leg, for example, to which a vertically polarized antenna is
attached puts metal along the antenna’s entire aperture. A horizontal tower
member typically imposes only a small amount of metal in the direction of
the electric field. Obviously, a diagonal obstacle would be somewhere
between. As the diameter of a cross-polarized obstacle becomes an
appreciable portion of a wavelength its effects become much more
pronounced. This is a good example to simulate for practice.
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In most instances, ignoring average sized cross-polarized obstacles is
acceptable as their effects are minimal. In fact, most problems can also
ignore most diagonal obstacles because the effects of co-polarized
obstacles are so much greater than diagonal obstacle effects. However, in
more critical applications, diagonals may be accounted for if necessary.
What has been done successfully with Obspat is to use the height of the
obstacle projected on the plane of the antenna’s electric field. This sounds
more complex than it is. If the antenna is vertically polarized, use a
diagonal obstacle’s vertical dimension. If the antenna is horizontally
polarized, use a diagonal obstacle’s horizontal dimension.
A diagonal obstacle that occurs say, in the center three feet of a vertically
polarized antenna, should have its height entered as occurring at the bottom
of the antenna. (Otherwise, the limited diagonal extent would be computed
as occurring from the bottom of the antenna’s aperture to the top of the
diagonal.) For example, the antenna’s aperture bottom is 100 feet above
ground. The diagonal obstacle’s vertical dimension is three feet. Its height
should be entered as 103 feet above ground level. The diagonal’s mid-point
is then used to define the distance and direction from the diagonal to the
antenna. This applies equally to horizontally and vertically polarized
antennas with diagonal obstacles. Recall that this approach is required
because only one dimension is entered for obstacle height in order to keep
data entry to a minimum.
As with other concepts in this Section, the user should create some
problems and then examine how the various parameters affect patterns.
Once known, many factors can be ignored or used as required. Be certain to
vary obstacle diameters and distances as well as heights and diagonal
angles.
For non-linearly polarized antennas the above patterns have a different
interpretation. Since non-linear electric fields rotate, during each revolution
the electric field will twice be co-polarized and twice be cross-polarized
with horizontal and vertical obstacles. At all other times vertical and
horizontal obstacles will be diagonal with respect to the electric field. In
this case the pattern will attain shapes of both the left and right patterns and
continuously pulsate between them. Thus, Obspat may also provide some
insight for cases of non-linear polarization.
64 Obspat Instruction Manual

Distances and directions for diagonal obstacles may be obtained by
averaging. Use the average distance for obstacle-to-antenna values entered
in ‘Ref Dis’ columns of the Obstacle and Antenna tables. Similarly,
directions entered into those tables should be entered in the ‘Ref Dir’
columns based on the obstacle-to antenna direction from the location of the
average distance point to the antenna’s phase center.
18.5 Non-circular Obstacles
Many common antenna supporting structures are comprised of members
with circular cross sections. However, significant numbers of structures
have other cross-sectional shapes. For example, obstacles made with angle
iron, flat strips and square or rectangular cross sections. Acceptable success
has been achieved using these shapes by assuming the following equivalent
circular diameters for the different cross sections.
Cross Section
Angle Iron (Web width=g)
Flat Strip (width=w)
Square (side=g)
Rectangle (length=L, width=W)

Equivalent Diameter
g
0.5w
1.18g
1.18square_root(LW)

If your problem is critical and employs non-circular cross-section
obstacles, some consideration should be given to using a calculation
method other than Obspat. This is particularly true if obstacle dimensions
are a significant fraction of a wavelength. Smaller dimensioned obstacles
are generally not a problem. We have received no negative feedback using
these equivalent diameters over the two decades that Obspat has been in
use.
While this warning may appear imprecise, the precision and sensitivity of
Obspat depends on values of several factors, not simply the physical
dimension of an obstacle. It is a function of at least frequency, distance and
obstacle size. In general, heed the warning if both sides of the inequality
given in Section 16.3 are nearly equal.
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18.6 Oversized Obstacles
Obspat, as well as most other predictive techniques and tools, is
constrained by design to operate only in the region in which it yields
accurate information. There are times when a problem is just beyond the
boundary of this region. Often Obspat can give good clues as to the shape
of a pattern when some condition falls outside Obspat’s accurate region.
Commonly encountered situations are mounting an antenna on a large
diameter obstacle or mounting an antenna very close to an obstacle. These
conditions may occur simultaneously, for example, when mounting a
relatively high frequency antenna near a large diameter monopole. The
inequality of Section 16.3 will cause Obspat to refuse to compute out of
range conditions to reduce the risk of providing incorrect answers.
Trending can come into play to give an idea of what might happen. Using
this technique may require that the user have some understanding of
consequences of actions taken to arrive at an accurate judgmental
extrapolation. For example, reducing an antenna to obstacle separation to
less than one-quarter wavelength may substantially impair the antenna
efficiency and change its driving point impedance, which in some cases
may indicate an acceptable solution but does not work when constructed.
So, use this technique carefully.
Set up the following problem in Obspat and follow along. Frequency = 860
Mhz. Obstacle: diameter = 36”, height = 200 ft., distance/direction = 0 (at
the reference point). Antenna: pattern = 3 dBd Omni, distance = 2 ft.,
direction = zero, CR agl = 100 ft. Now depress Enter (or click GO). Obspat
refuses.
To get some idea of what the pattern might look like, move the antenna
away from the obstacle or, equivalently, reduce the obstacle diameter, or
both. Taking the first choice, move the antenna to, say, 25 feet. Obspat will
now compute a pattern. Now start reducing the antenna distance in say,
one-foot increments and observe the pattern behavior. As the antenna is
moved closer to the obstacle the small side lobes become less frequent and
the depth of the null increases slowly, until the distance reaches about 17
feet.
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Now, leaving the antenna at 17 feet, try reducing the diameter of the
obstacle in small increments and observe the changes. Then go back to
reducing the separation distance. The results should indicate that as the
diameter of the obstacle is reduced, the number of side lobes decreases. As
the separation distance decreases the depth of the main null increases.
This process can at least indicate a useful trend of a particular configuration
even when some parameters are outside Obspat’s accurate region. The
trending technique has frequently helped in making go, no go decisions.
18.7 Creating Antennas Using Fundamental Elements
There may be some temptation to attempt to create antennas, such as yagi
or log-periodic antennas, with directors and reflectors. Obspat cannot
calculate these types of antennas because it does not contain the interaction
mathematics required for parasitic or closely coupled elements. In fact,
Obspat assumes that there is no interaction between any antennas.
Creating patterns from fundamental entities is not for the inexperienced.
However, in some cases it may be successfully accomplished, requiring
some advanced knowledge and experience with Obspat and antennas.
Most of the time the antenna patterns used for Obspat problems are
obtained from antenna manufacturer’s measurements of actual antennas.
Every once in a while an application presents itself that requires a different
approach.
For example, using a four-element, exposed dipole antenna where the two
standard patterns, omni and elliptical, are not exactly what is needed.
Obspat can be used to adjust directions of the four elements to derive a
modified pattern. To accomplish this, the dipoles along with the support
pipe may be used to obtain the pattern. (The folded dipoles used on these
antenna types are the same as unfolded dipoles, except the folded dipoles
have higher terminal impedances.)
This may be accomplished by estimating the diameter of the mast and the
separation distance of the dipoles. This problem is set up in a Situation
named ‘Section18-7Example1’. Select this Situation and press Enter. Note
the horizontal plane pattern is omnidirectional. Now, change all the dipole
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directions to zero, depress Enter. You now have the elliptical version of the
antenna. Thereafter, changing individual dipole directions yields all of the
possible pattern variations.
Note that Obspat does not yield the correct omnidirectional gain for this
antenna, which normally is 6 dBd. Why not?
The individual dipoles and their interactions with the mast are correct.
Pattern shapes are correct. The array gain is incorrect because the antenna
aperture has been expanded only in the vertical plane. Obspat does not
calculate vertical plane patterns. In Section 17.5 we learned that for every
doubling of aperture the gain is doubled. In this instance, the vertical plane
aperture has been increased by 4 times which should yield a vertical gain of
6 dB.
The proper way to work this problem in Obspat is to use one dipole+mast
pattern and then stack four of them in the usual manner. (Recall that Obspat
does accommodate vertical stacking by assuming the aperture gains
mentioned above.) To accomplish this, place one vertical dipole a quarter
wave North of a 2-inch mast. Then save this pattern as an antenna. Once
saved, the dipole+mast antenna may be used to compute a 4-unit stack of
collinear antennas in the normal manner. Note that since the antenna+mast
combination already uses a mast, the final pattern should consist only of the
stack of four antennas, with no (additional) mast. Changing orientation of
the stacked units yields all possible pattern shapes with their correct gains.
A Situation named ‘Section18-7Example2’ is included showing the basic
set up for obtaining the dipole+mast combination. This pattern was saved
as an antenna with the name ‘dipole 2inch mast’. A Situation named
‘Section18-7Example3’ is the final situation that yields the correct pattern
information.
Rotate the individual antennas (by changing Pat Dir values) and observe
some of the attainable patterns.
Once a desired pattern has been achieved, the derived antenna pattern may
be saved as an antenna. Then this pattern may be used as a normal antenna
and may be side-mounted on a tower, etc.
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18.8 Using Obspat’s Automatic Pattern Generator
This pattern generator was created to supplement only omnidirectional
antennas entered by hand. Patterns for other antennas may be generated
using the techniques of Section 18.9.
To enter by hand an omnidirectional antenna, select from the menu Tools>
Antennas> New. The main antenna screen will appear. In the table
corresponding to the plane in which the omni pattern is desired, enter one
azimuth-gain pair. Typically the azimuth entered is zero and the gain is the
desired pattern gain. After naming the antenna and filling desired fields
(file name, notes, frequency, polarization, etc.) click GO. A dialog will
appear asking if the user desires Obspat to provide the pattern in the
unoccupied table. A yes response causes the pattern generator to produce a
pattern in that table. For example, if the antenna is to be omni in the
horizontal plane, the single azimuth-gain pair is entered in the horizontal
plane table, the other plane table is filled by Obspat. If the omni pattern is
to be in the vertical plane, then Obspat fills the horizontal plane table.
Suppose it is required to generate a pattern in the vertical plane for an omni
antenna that has an omni horizontal plane pattern, the gain of which is
unknown, but the number of antenna elements in the vertical aperture is
known. The gain may be calculated using the expression Gain =
10 Log10(number of elements). Entering this value in the horizontal plane
table will produce the desired vertical plane pattern.
Patterns generated using this method are based on half-wave dipoles
separated by one-wavelength which is a common element and spacing used
in antenna arrays.
18.9 Manually Create Vertical (or Horizontal) Plane Patterns
This Section does not pertain to creating a pattern by entering azimuth-gain
data in the Horizontal or Vertical Plane input tables on the main antenna
screen. That process creates an antenna when the pattern values are known
and is discussed in Section 10.
In this Section we compute a pattern by combining one or more patterns
stored in an Obspat antenna file. This process can provide accurately
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synthesized patterns. The patterns produced may then be used for either
plane as desired.
One of the most used antenna elements in making an array is the vertical
dipole. For instance, many antennas are composed of arrays of vertical
dipoles stacked vertically to increase gain. This arrangement produces an
omnidirectional horizontal pattern and a vertical pattern that concentrates
energy near the horizon.
To determine the vertical pattern for such an array is straightforward if you
know how many elements to use. If you do not know how many elements
because, for example, an antenna for which you are attempting to estimate
the vertical pattern has an opaque casing, you can figure out how many
elements would be required to obtain an omni gain equal to that of the
antenna. The number of elements may be easily calculated on a hand
calculator. Divide the gain in dB by 10 and use that value as a power of 10
by pressing the calculator key 10x. The number of elements is the result
rounded to the nearest whole number. In math notation, Nelements = 10Gain/10.
For example, an omni antenna with a 6 dB gain has 106/10 = 3.98 = 4
elements.
If the gain is unknown, compute the wavelength of the operating frequency.
Divide that into the length of the aperture. Wavelength (ft) =
983.56/Frequency(MHz) or Wavelength (m) = 299.79/Frequency(MHz).
The number of elements is then (aperture length)/Wavelength rounded to
the nearest whole number. If the fraction of the number of elements (before
rounding) is near 0.5, round down to the nearest whole number because
many antennas have about 1/4 wavelength empty space at each end of their
casings.
With the number of elements known, it becomes a simple matter to
synthesize the pattern using Obspat. Using the vertical pattern of the
‘Omni 0 dB’ pattern, enter its name in the ‘Ant/Pat Name’ column the
number of elements times. Fill in the Power column using, in percent, the
constant value of 100/(number of elements). Press Enter and you have the
completed pattern. When using dB for the Power loss, the correct Power
entry for each element is 10 Log10(1/number of elements)
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Here our objective is to compute the vertical plane pattern of vertical
dipoles by stacking the dipoles because this process may be extended to
any antennas. To do this we work with the vertical pattern of the vertical
dipole. First, construct an antenna with the dipole vertical pattern as its
horizontal pattern. Accomplish this using Open Antenna from the File
menu and selecting the Omni 0 dB antenna. Then click Save As and enter a
unique name for the new antenna. Then click Add H Pat and reselect the
Omni 0 dB antenna, selecting its vertical pattern. The pattern values will
appear in the Horizontal Plane table. Save the new antenna and Cancel.
Click Clear to reset Obspat. Then enter twice the new antenna’s name in
the Antenna table. Activate one of the two antennas and display the
horizontal pattern by clicking GO. The resulting pattern is, as expected, the
same as the vertical pattern of a vertical dipole with the main lobe at 0 and
180 degrees and nulls at 90 and 270 degrees. Activate the second antenna
and set each power to 50 percent. Run the pattern. The pattern has the same
shape except its gain has increased to 3 dB. This is not what is expected
and is definitely not the correct pattern. What has happened? Working with
patterns in the horizontal plane, Obspat, because it normally assumes
vertical stacking, has simply stacked the patterns and not computed any
antenna interactions. But, the need here is to compute a pattern resulting
from interacting antennas.
The solution is to stack these patterns horizontally, just the way they would
appear in the real case of vertically stacked dipoles, only rotated by 90
degrees. This roundabout method is necessary to avoid Obspat
automatically assuming the antennas are stacked vertically by doubling the
power gain for each doubling of the vertical aperture, a calculation
performed because Obspat does not compute vertical patterns.
Therefore, space the antennas horizontally by one wavelength. For
example, if the frequency is 450 Mhz, space them 2 ft apart in a 90-degree
direction. Adjust the power, in percent, of each antenna to 100/number of
antennas. The resulting pattern is now correct and has been computed from
vertical plane patterns.
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Continue adding antennas, simultaneously changing the powers, to see how
the pattern changes. The resulting pattern may be saved as an antenna and
appended in either plane to other Obspat antennas, if desired.
Using this technique, the vertical plane patterns of any antennas may be
computed, assuming they are to be stacked in the vertical plane. The
resulting pattern may then be added to an antenna using the ‘Add V Pat’
option.
18.10 Beam Tilt/Null Fill Considerations
Electrical beam tilt and null filling are widely practiced in the antenna
industry. In Section 18.9 a method for creating vertical plane patterns was
discussed. In most of the generated patterns maximum radiation occurs in
the horizontal plane. Further, pattern nulls are theoretically infinitely deep.
Frequently there is need to have maximum radiation occur below the
horizon (beam tilt) and/or to have some energy radiated in null regions
(null fill).
When an antenna is comprised of multiple elements in the vertical plane
there are several methods to tilt the beam and/or fill nulls. This may be
accomplished by adjusting the magnitude and/or phase of the power fed to
one or more of the vertical elements. This is particularly easy in Obspat,
which provides the designer with fast results and excellent graphical
visualizations necessary for cut and try designs. It is suggested that the
‘Include Expanded’ option be enabled for the following.
Changing power levels and/or phases to elements is typically accomplished
in the transmission lines feeding the elements. It may also be accomplished
using discrete components such as transmission lines, power dividers,
capacitors and inductors, alone or in combination. Here we confine
discussions to power levels and phases.
Using the techniques of Section 18.9, create an antenna with its horizontal
plane pattern derived from the vertical plane pattern of the Omni 0 dBd
antenna. Then create a situation, using four of the new antennas spread in
the horizontal plane. Each antenna is fed equal power. Now change the
phase of the first element to 10 degrees by entering 10 in the Cur Ø column
of the antenna table. Clicking GO produces some observable change.
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Remember that the displayed pattern is rotated by 90 degrees compared
with a normally displayed vertical pattern. Continue changing the phase of
the element and notice the beam tilt. The results show changes to the beam
tilt with some changes in null depths. Also notice that with higher beam
tilts the maximum gain drops slightly. This is a real, measurable effect.
Return the phase to zero. Now adjust the power to the first element. This is
not quite so easy as the three non-affected elements must maintain equal
powers and the sum of the powers to all four elements must be 100. Try the
powers at 22, 26, 26 and 26 percent. Then adjust power to 19 and 27x3
percent. And so on. The results should show very little beam tilting, most
of the effects occurring to null depths.
The only remaining adjustment combination is to simultaneously change
both the phase and power levels, which is the most common means
employed.
Sometimes phases are retarded for all elements by making the
transmissions lines feeding each element progressively longer.
When an antenna consists of a large number of elements, usually for the
purpose of employing higher total input powers, the power is often divided
in a tree-like feed scheme employing groups of elements, called bays. In
such cases, all elements within a bay are fed equal, in-phase powers. Beam
tilting and null filling is then accomplished by adjusting power levels and
phases for bays instead of individual elements.
The particular method used depends on the specific needs for null fill and
beam tilt. It also depends on the physical characteristics of the antenna
including its size, shape and supporting methods.
18.11 Quarter-Wave Offset Nulling Techniques
An important technique for creating patterns that reduce radiation in a
specified direction is commonly called ‘quarter-wave offset’. This
technique has been used extensively to provide ‘protection’ toward
sensitive installations such as the National Radio Astronomy Observatory
(NRAO), various Federal Communications Commission monitoring
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stations or for any other purpose for which reduced power or signal range is
required.
This technique is simple to produce and can be made very stable over wide
ranges of climatic conditions including wind and ice. It may also be made
to function over relatively large bandwidths. Important features include
pattern nulls that are accurately positioned and stable and adjustable in
magnitude. Null depths from shallow to deep are available to the designer.
The method provides signal cancellation in one direction and signal
addition in other directions. The simplest case is to use a pair of identical
omnidirectional antennas. Recall that a pair of (omni) antennas mounted
collinearly (one directly above the other), each fed 50 per cent power,
produces a horizontal plane pattern that has 3 dB greater power, which is
double the power, than one of the antennas fed 100 percent of the power.
This happens because the vertical aperture of the antenna has been doubled.
Two antennas of the same type are separated horizontally by one-quarter
wavelength. Then the power fed to one of the antennas is phase delayed by
one-quarter wavelength, usually by extending the length of transmission
line feeding the delayed antenna.
Wavelength/4

Ant 1

Ant 2

50%

100% Power Input

50%

Antennas
Vertical Dipoles
Patterns - Omni
Gain - 0 dBd

Longer by
Wavelength/4

50/50 Power
Splitter

The plan view sketch shows a typical quarter-wave offset system. The
antennas may be mounted one above the other, joined at the middle (one up
and one down), or at the same elevation. When mounted joined at the
middle, a narrow vertical pattern null will occur on the horizon. The other
two configurations produce a broad null of the horizontal pattern as shown
below.
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Referring to the sketch, energy arriving at a receiver located toward the
right is added because Ant 1 energy is physically delayed by 90 degrees
(one-quarter wavelength) with respect to Ant 2. However, energy from Ant
2 is electrically delayed by the same amount. Thus, the signals from the
antennas are both delayed the same amount and arrive at the receiver
in-phase.
A receiver located in the up and down directions, sees energy from the two
antennas arrive 90 degrees out-of-phase. (This assumes the distance to a
receiver is much greater than the distance separating the antennas.) Because
the energy consists of a magnitude and phase, the total magnitude from
both antennas must be determined vectorially to account for the phase
difference. This magnitude equals one. That is, the power received is no
greater from the two antennas than it would be from a single antenna.
Toward the left a deep null is produced. If everything were perfect, there
would be complete cancellation of energy at the receiver because signals
arriving from both antennas are 180 degrees out-of-phase. Ant 2 is delayed
by 90 degrees physically and 90 degrees electrically with respect to Ant 1.
From this humble beginning, arrangements to reduce radiation in any
direction may be achieved. But, the phase centers of the two antennas must
lie on a line drawn between the transmitting site and the site to be
protected. That is, along the azimuth the reduced radiation is required.
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The real power of this method lies in the fact that any two antennas may be
used to reduce radiation in a particular direction. Moreover, by adjusting
the phase and/or the power division, the null depth may be accurately set
using inexpensive, easily available components.
Consider also the use of directional antennas. If the protection requirement
is great or if the azimuthal arc of protection is large, it is often an advantage
to employ antennas that already have reduced radiation, such as panel
antennas. Combining an antenna’s natural null with further quarter-wave
offset null reductions can achieve reliable, stable and extremely deep nulls.
This configuration is often used with its antennas skewed as described in
Section 18.12.
18.12 Skewed Antennas
The term ‘skewed’ antennas refers to two or more antennas having their
main lobes of radiation aimed at different azimuths.
Skewing of antennas is frequently employed to expand the width of
patterns, most often in the horizontal plane. Any number and types of
antennas may be used. Here, knowledge of antenna phase center locations
becomes important.
Other uses for skewed antennas would include placing a ‘bump’ or notch in
a pattern. Keyhole patterns, for example, might use antennas to produce a
lower level omni pattern with a large bump in gain at some azimuth. This
might result from a marriage of narrow beam directional and omni
antennas.
Creating a pattern notch could be accomplished using a similar
arrangement with the proper power division and one antenna fed out-ofphase.
There are myriad other uses. For example, using a broad beam pattern with
a very narrow beam pattern to change the rate of gain decrease of the broad
beamed pattern. Suppose the broad beamed antenna has a half-power
beamwidth of 150 degrees and a fairly deep null in the back. From the halfpower point of the pattern to the null, the gain changes some number of dB
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per degree of azimuth. A narrow beamed antenna often has greater gain
decay rate than the broader beamed one. By combining the two antennas it
may be possible to cause the pattern to decay faster over a particular
region. This technique is usually prompted by desperation while trying to
provide as much energy as possible at one azimuth while reducing energy
as much as possible toward a nearby azimuth.
To determine the results of skewing patterns, simply enter the antennas in
Obspat and divide the power in some ratio. Adjust the pattern azimuths by
entering their directions in the ‘Pat Dir’ column.
Usually, but not mandatory, the antennas are pivoted, or skewed, about
their phase centers. Sometimes however, as in the quarter wave offset
method described in Section 18.11, the phase centers are purposely offset
from one another. It should be noted that skewed antennas are frequently
used with directional antennas in quarter-wave offset configurations to gain
the advantages of a broader beam and deep pattern notch in a controlled
direction.
When using an antenna, such as a yagi or log-periodic, where the phase
center is some distance from the antenna’s mounting point, a special
bracket must be provided to accomplish the proper mounting support while
maintaining the skew angles with phase centers at their desired locations.

19 High Tech Antennas
Antennas referred to in this section are generally complex, under some form
of algorithmic control, and typically used because of their capabilities to form
complex static and dynamic radiation patterns. Still in their infancy, these
antennas hold great promise for new approaches to system features,
capacities and configurations.
19.1 Overview of Beam Forming Antennas
During the creation of this manual the focus of much antenna research has
been in the area of real-time beam forming antennas using adaptive arrays (of
antennas). The goal of this research is to create antennas with variable
radiation patterns that may be changed in response to a changing radiofrequency environment, such as moving mobiles or interfering sources that
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move and come and go. These antennas provide patterns with maximum
gains in directions toward desired locations and very reduced gains toward
interfering sources. The variable gains may also be employed to tightly
control system power levels for such systems as code-division multipleaccess (CDMA) and others that require precise signal levels for maximum
efficiency.
Invariably these antennas are comprised of a few or many individual
radiating elements arrayed in some fixed configuration. Some have elements
configured as a matrix such as on a checkerboard; others have elements
distributed along a straight line. Undoubtedly, different configurations will
also be used.
For our purposes, it is more important to be aware of the basic principles of
how these antennas form their beams than to know the mechanism behind the
changes. The same concepts already discussed and observed in Obspat also
provide the basis for this new class of antennas. Simply stated, the phase and
amount of power fed to each element along with the element’s position is
used to obtain precisely aimed pattern peaks and nulls. Make up a problem
using five or six dipole or isotropic antennas positioned at half-wave
increments along a line. Vary the powers and phases and observe the
resulting patterns. Then, shut-off every other antenna by disabling their
checkboxes and readjust the powers and current phases of the remaining
antennas. Notice the difference in the available number of nulls. By
simultaneously using antennas at various spacing and by adjusting power and
phase, infinitely many patterns may be created.
The manner of determining each antenna’s correct power and phase to create
a needed pattern is very involved and requires a great deal of computer power
to keep the pattern changes accurate in real-time. But, however it is done, the
fundamentals are familiar. The antenna provides a radiation pattern that may
be visualized in the same manner as any other antenna.
19.2 High Tech Antennas and Obstacles
Since high tech antennas provide and/or accept r-f energy they are subject to
the same distortions as any other antennas. As before, we will discuss the
more intuitive transmitting case with the understanding that the Theory of
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Reciprocity still insists that the receiving case is the same as the transmitting
case.
An antenna that radiates energy toward a metallic object induces currents in
that object which causes the object to reradiate energy. The strength of the
reradiated energy depends mainly on the distance between the source and
object and the strength of the energy the source radiates toward the object.
This is always true for common metallic objects. Variations in the source
power produce corresponding variations in reradiated power. With rapidly
changing conditions that vary statistically from very low to the maximum
gain capability of the antenna, we assume that all gains are possible and
equally probable. This implies that the envelope of possible pattern variations
equals the maximum antenna gain capability in any given direction. The
envelope could be omnidirectional or directional. For example, some beam
forming antennas might have a cardioid envelope shape because they employ
metallic back panels that restrict rearward radiation.
Most antennas are mounted in a fixed position. Obstacles also do not usually
change position. Considerations for making some assessments of pattern
distortions can be made using an antenna’s pattern envelope and fixed
obstacles. This is the same problem as any other we have investigated. But
because the source gains vary randomly, the results using the envelope will
show a worst-case condition.
Recall, as the source-to-obstacle power lessens, so does reradiation and the
potential for distortion. The only other factors that cannot be accounted for
are the source phase and antenna phase center, which will undoubtedly
change with each different selection of antenna elements and change in
current phase. For example, to obtain a given pattern, a beam forming
antenna will select a group of elements, phases and powers. An instant later a
different group of elements might be selected with different phases and
amplitudes producing a different effective phase center and a different energy
phase radiated toward each obstacle.
19.3 How Can Obspat Be Employed
In spite of the above variations, each scenario is a problem for which Obspat
can provide some insight. First, it may be assumed that any metallic object
occurring in the aperture of the antenna is going to cause some pattern
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distortions. The larger and closer the object is to the antenna the greater are
the resulting distortions. Knowing that the distortions will be greatest when
the antenna gains toward obstacles are greatest, using the maximum possible
gains should display the worst-case distortions. The maximum possible gains
are by definition the antenna’s envelope gains.
The potential for pattern degradations can be estimated using the antenna
envelope by applying the same familiar techniques used throughout this
manual. Thus, the effects from guy wires, mounting brackets, tower
members, transmission lines, and other such obstacles may be evaluated in
the normal manner with Obspat.
There is a caveat, however. While the distortion magnitudes will be quite
accurate, directions at which the pattern distortions occur will not necessarily
be accurate. This relates primarily to not knowing the exact location of the
antenna’s phase center, which determines distances and directions between
obstacles and antennas. It is likely, however, that the physical center of the
antenna will be close to the effective phase center, as with other antennas.
The pattern distortions can thus occur anywhere in the pattern envelope with
a magnitude of approximately the greatest disturbance computed by Obspat.
Should high tech antennas employ circular or elliptical or other rotating
polarizations, the considerations discussed in Section 18.4 will add another
level of interest to problems. Using Obspat to display conditions when the
polarizations are vertical or horizontal may yield useful information. For
example, the range of variation between the two polarizations is useful to
understand possible power variations due to obstacles.

20 Troubles, Bugs or Problems
20.1 Macintosh to Windows Issues
When moving Antenna, Situation or other files from Mac to Windows
computers, the process may leave unwanted directory entries in the
respective folders on the Windows machine. This information derives from
the fact that Mac files use two part files, data and resources. The resources
parts are not used by Windows and should be discarded. Any files
beginning with a dot-underscore sequence (._xxxx) should be discarded.
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Files beginning with dot-DS-underscore (.DS_xxxx) should also be
discarded.
Two menu items may be used to rid antenna and situation folders of these
files. Select the menu Tools> Rebuild > Antenna (or Situation) item. The
‘Rebuild’ function will delete the unused files. These files can be manually
deleted by moving them into the trash.
20.2 Trouble Reports And Program Feedback
Please direct your feedback comments and trouble reports via e-mail to
obspat@cox.net. Responses will be returned as promptly as possible.
20.3 Features Requests
Please forward all features requests to obspat@cox.net. Unless further
understanding is required, there typically will be no responses. The next
program update cycle will contain all feasible features as requested.
20.4 Other Issues Requiring Communications
There are few resources available for answering questions or tutoring.
Obspat was converted and made available in a fast, modern format mainly
to sustain existing clients and users needing continuing access to its
information. This manual was written to enable both experienced and
inexperienced persons to relatively easily obtain accurate, useful and
valuable information from Obspat. It is believed these goals have been met.
It is also understood that confusion can arise and issues can get quite
complex. Therefore, as time permits, questions can be discussed personally.
However, extended questions relating to the practice of antenna
engineering and pattern development may be considered tutorial and be
subject to engineering fees.
Direct inquiries to:
Arthur K. Peters
Consulting Engineers
5422 NW 91st Boulevard
Gainesville, FL 32653 USA

www.akpce.com
Phone: 352-331-0149
E-mail: obspat@cox.net
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Antenna pattern, 40
Beam Tilt, 41
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ObspatPreferences, 5
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Batch processing, 45
Dual file formats, 45
Folder, 44
Operation, 44
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M
Macintosh to Windows issues, 80
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Menu
File, 6
Tools, 7
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Null fill, 71
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Starting program, 8
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Ref, 17
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Obstacles
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Non-circular cross-section, 64
Non-cylindrical, 64
Oversized, 65
Omni antenna, 42

P
Pattern
Automatically generated, 68
Composite, 32
Create from simple antennas, 67
Create horizontal plane, 69
Create vertical plane, 69
Cursor pattern values, 33
Definition, 53
Envelope Only, 32
Include V Plane Pat, 30
Included Expanded, 31
Max, Min values, 33
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Using oversized obstacles, 65
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Co-, 62
Cross, 62
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Linear, 62
Non-linear, 62, 80
Position calculator
Antenna, 23
Obstacle, 25
Preference file. See File, Preference
Preference Page
Print, 9
Resolution, 11
Selection Criteria, 13
Units, 12
Print, 9
Number of data points, 10
Pattern, 20
Situation file, 28
Program Setup, 9

Q
Quarter-wave offset nulling, 73

R
reference point, 17
Reporting Obspat problems, 81
Resolution, 11
RMS, 34

S
Save, 42
Setup program, 9
Sine waves, 52
Situation, 25–28
Change name, 26
Creating, 25
delete, 27
Folders, 27
Name, 25
Note field, 27
Save, 26
Save Situation As, 26
Select, 26
Select situation folder, 27
Skewed antennas, 76
Starting Program, 8

T
Tapered structure and components, 60
This Polarization, 40

V
View Plane, 29

U
Units, 12
Azimuth, 40
Gain, 40
Relative, 40

W
Warning indicator, 30
Wavelength, 70
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